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IMPORTANT-READ CAREFULLY: This Software License Agreement (“SLA”) is a legal agreement between you (either an individual or 
a single entity) and G.NEIL (“G.NEIL”) for the software product found in this package, which may include associated media and printed 
materials (“SOFTWARE PRODUCT”). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by 
the terms of the SLA. If you do not agree to the terms of this SLA, do not install or use the SOFTWARE PRODUCT; you may, however, 
return it to G.NEIL for a full refund.  
 
Software Product License 
The SOFTWARE PRODUCT is licensed, not sold; G.NEIL retains full ownership rights to the SOFTWARE PRODUCT. G.NEIL, upon 
your payment of the applicable fees, grants to you a nonexclusive license subject to the following conditions:  
 
The SOFTWARE PRODUCT may not be exported, distributed, rented, leased, sublicensed, or used on a service bureau, bulletin board, or at 
any time-sharing system. It may not be copied, altered, modified, translated, or used to create a derivative work. You may not reverse 
engineer, decompile or disassemble the SOFTWARE PRODUCT. You may use the SOFTWARE PRODUCT for your individual use or for 
use within your company, but you may not use the SOFTWARE PRODUCT to produce attendance records to be sold or distributed outside 
of your company.  
 
Purchasers who have paid for a license may currently run and use the SOFTWARE PRODUCT for the number of licenses purchased 
 
Your right to use or install the SOFTWARE PRODUCT automatically terminates upon failure to comply with any provision of this SLA, 
violation of any term of this SLA, or upon your destruction of all copies of the SOFTWARE PRODUCT. In any of the foregoing 
circumstances, you must remove the SOFTWARE PRODUCT from your computer’s hard drive, application server or other mass data 
storage devices and cease use of the product. The License is deemed accepted and delivered in the State of Florida and shall be construed, 
interpreted and governed by the laws of the State of Florida, without regard or effect given to its or any other jurisdiction’s choice of law 
jurisprudence. 
 
G.Neil warrants the SOFTWARE PRODUCT will operate in accordance with its published specifications for a period of ninety (90) days 
following the date of purchase (30 days for opened software). In the event the SOFTWARE PRODUCT fails to operate in accordance with 
the published specifications during that period, you may return it to G.Neil. G.Neil will, at its option, repair or replace the defective program 
or refund the purchase price. THIS IS YOUR SOLE AND EXCLUSIVE REMEDY. 
 
G.Neil assumes no responsibility for the purchaser’s use of this software or any decision the purchaser makes in violation of 
federal, state or local law. By selling this product, G.Neil is not providing legal advice.  The purchaser is urged to consult with 
legal counsel to address issues specific to the purchaser's business, including the application of state or local law. 
 
G.NEIL SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH 
RESPECT TO THE USE AND INSTALLATION OF THE SOFTWARE PRODUCT, DEFECTS IN PRODUCT MEDIA AND THE 
PROGRAM, AS WELL AS THE SOFTWARE PRODUCT’S INTERACTION AND COMPATIBILITY WITH OTHER PROGRAMS, 
SYSTEMS, AND HARDWARE. IN NO EVENT SHALL G.NEIL BE LIABLE FOR ANY LOSS OF PROFIT OR ANY OTHER 
COMMERCIAL DAMAGE, INCLUDING, BUT NOT LIMITED TO, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER 
DAMAGES EVEN IF G.NEIL HAS BEEN ADVISED OF THE POSSIBILTY OF SUCH DAMAGES. THE SOLE AND 
EXCLUSIVE REMEDY AVAILABLE TO PURCHASERS/LICENSEES UNDER THIS AGREEMENT IS LIMITED TO 
REPLACEMENT, REFUND OF SALES PRICE, OR FULL CREDIT. FAILURE TO COMPLY WITH THE TERMS OF THIS 
SOFTWARE LICENSING AGREEMENT IS STRICTLY PROHIBITED AND MAY VIOLATE COPYRIGHT LAW. 
 
Optima is a trademark of G.Neil. Microsoft, Windows and Internet Explorer are registered trademarks of Microsoft Corporation. Entire 
work © G.Neil 2004. All Rights Reserved. 
 
 

We welcome your suggestions and comments. Contact us at G.Neil, 720 International Parkway, Sunrise, FL 33325 
Tel (800) 999-9111 – Fax (954) 851-1214 – Customer Service e-mail tcs@gneil.com 

Technical Support Tel (888) 925-7740 or www.gneiltechsupport.com 
Shop Online at www.gneil.com 
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Chapter 1  

Welcome! 
 
 
Thank you for choosing Optima to track your company’s employee information. Our 
software application includes many features based on the suggestions of our customers, 
and we certainly welcome any further comments or improvements you may have. 
 
Optima COBRA was created to help employers administer continuation coverage in 
compliance with the Consolidated Omnibus Budget Reconciliation Act (COBRA) and the 
Department of Labor’s final regulations (issued May 26, 2004) affecting COBRA notice 
requirements.  The final regulations apply to COBRA notice obligations that arise on or 
after the first day of the first plan year beginning on or after November 26, 2004.  Thus, 
calendar year plans must comply beginning January 1, 2005.  
 
COBRA continuation coverage provisions generally require group health plans to provide 
participants and beneficiaries who under certain circumstances would lose coverage the 
opportunity to temporarily extend benefits under previous group health coverage. The 
final regulations set minimum standards for the timing and content of the notices 
required under the continuation coverage provisions and establish standards for 
administering the notice process. 
 
When combined (Optima Attendance, Records, Time Clock and COBRA), these 
powerful tools help you keep critical employee information without entering data twice. 
 

Software Features 
¾ Open-ended licensing – Unlike many human resource software applications, 

Optima does not require annual licensing. However, we do encourage you to 
purchase upgrades so that you have the latest enhancements and newest features to 
make your job easier. 

¾ Easy, standalone PC installation – We designed Optima to be simple to install and 
get up and running.* 

¾ Password security – Anyone who uses the program must have a login ID and 
password, and you can set different access levels for each user. 

¾ Data import – If you already have information from a spreadsheet or other 
program, you can save time setting up Optima by importing it. 

¾ Reminders – Set pop-up reminders for important dates, such as employee 
anniversaries, birthdays, I-9 renewals and reviews. 
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¾ Reports – You can choose from several standard reports and change options to get 
the information you need. Export information to other file formats such as Excel or 
text, too.  

¾ FREE Technical Support – When you’ve thoroughly searched the help and 
troubleshooting information provided in this User’s Guide, you can contact 
Technical Support for free assistance. (See page 66 for contact information.) 

¾ Automatic reminders – Instantly create recurring reminders for events for all 
employees! See page 54 for details. 

¾ Add file attachments to notes/comments – Store all documentation in one place! 
Attach Word, Excel, PDF and image files to any notes or comments field. For 
instance, you can attach a MyBiz Forms FMLA Request Form to the comments field 
of the Benefit Detail screen for that employee. There’s also a full text editor available 
now. See page 129, Appendix E. 

¾ Quick print reports – In each program feature, you’ll find a print icon that lets you 
quickly create related reports. Combined with the new, faster Employee Select 
Column, this makes printing reports a breeze. 

 

Unlocking the Demo 
If you have already installed the demo of Optima, you can unlock it by following the steps 
listed here.  
 
1. Open Optima.  
2. Select Alter Current Product License from the Help menu.  
3. Select EDIT for the program you want to unlock and enter the Product Key you 

received with your purchase. This will be located inside the front cover of this User’s 
Guide in the lower right hand corner or sent to your e-mail address. 

4. Click OK. If the confirmation message does not appear, verify that you entered the 
correct key. The Product Key is not case-sensitive. 

Note: There is a different product key for each G.Neil software product. 
 

System Requirements 
Required 
¾ Windows 98 (SE) or later 
¾ Pentium 266Mhz or faster processor 
¾ 64 MB available RAM (Random Access Memory) 
¾ 50 MB available hard disk space 
¾ Access to a CD-ROM drive 
¾ SVGA monitor with 800 x 600, 16-bit color depth or higher 
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Recommended 
¾ Pentium III or higher processor 
¾ 128 MB available RAM (Random Access Memory) 
¾ 50 MB available hard disk space 
¾ CD-ROM drive 
¾ SVGA monitor with 1024 x 768, High Color or higher 
¾ Windows-compatible graphics quality printer 
 

Network Requirements 
¾ Windows-based Server or PC – The included Interbase database must be installed 

on a Windows-based operating system. You may run the database on a Windows-
based server or PC connected to a non-Windows based network, such as Novell.  

¾ A static (persistent) IP address so that the database will be always connected to 
the client application 

¾ Proper user license – The database will only allow the purchased number of users 
to be connected at any one time to the database. Wide-Area Networks (WAN) 
require a WAN license based on the number of geographic locations. The Product 
Key is affixed to the inside cover of the CD sleeve. 

¾ CD-ROM drive or Internet access to our software product download area on 
www.gneiltechsupport.com.
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Chapter 2  

Installation 
 
 
 Optima applications can be installed on a single standalone workstation or a network for 
database sharing among several users, depending on your needs.  
 
Regardless of which license you purchased, you may install the database to a network 
directory for the purpose of backup. Please consult your network administrator before 
installing to a network directory. 
 

License Options 
The license options currently available: 
¾ Single User – Only one user can run the program at a time.  
¾ Five Users – Up to five users can run the program at the same time when connected 

to a single, common database. 
¾ Ten Users – Up to ten users can run the program at the same time  when connected 

to a single, common database. 
¾ Unlimited User License – Any number of users can run the program at the same 

time when connected to a single, common database.  
¾ Wide-Area Network (WAN) License – This is an unlimited multi-site license 

based on the number of geographic locations where application clients are 
connecting to a single, common database. 

 

CD Menu Instructions 
To begin installing Optima, follow these steps: 
1. Close ALL running programs.  
2. Insert the Optima CD-ROM into the appropriate drive of your computer.  
3. The menu will appear. Select which product you want to install. (If the installation 

menu does not appear, click Start, Run. In the dialog box type D:\setup. exe where 
D: is the letter of your CD-ROM drive. Click OK or press Enter. ) 

4. Once the installation procedure begins, follow the on-screen instructions to install 
the software. See Setup Types below for more information. It is recommended that 
you accept the default setting for each step of the install process. If you are installing 
the software in a network environment (Client-Server Installation), you should 
consult your network administrator prior to installation. You must have proper 
network rights in Windows 2000, NT and XP in order to install Optima software. 

5. When installation is complete, the G.Neil program group will be added to your Start 
menu and an Optima icon will be on your desktop. 
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Setup Types 
¾ STANDALONE: Use this option if you are installing to a standalone computer. 

This will install both the program files and database files to your local drive.  
¾ SERVER: This is the first of two steps in the Client-Server Installation, either for 

true client-server configurations or peer-to-peer network that may be using a 
workstation PC for the database. Choose this option to install the database and 
application files on the Server and before installing the Client application to PC 
workstations. 

¾ CLIENT: This is the second step in the Client-Server installation. 
 
After clicking on a Setup Type, you will have the following options: 
¾ EXPRESS: We recommended that you select this option if you are installing or 

upgrading Optima for the first time. This will take you through the installation 
process with minimum user intervention.  

¾ CUSTOM: This option is for Advanced Users who have specific installation needs.  
 
Note – A Client-Server Installation is recommended. The database is more secure 
than if you install it on a Standalone computer, especially when installing Optima Time 
Clock. When running Optima Time Clock on a Standalone computer, you run the risk of 
someone changing the clock settings and creating false time card entries. On a Client-
Server Installation, the database and time are pulled from the server, not from the client 
workstation. 
 

Network Installation 
To install to a network requires these items: 
¾ Windows-based Server or PC – The included Interbase database must be installed 

on a Windows-based operating system. You may run the database on a Windows-
based server or PC connected to a Non-Windows based network, such as Novell.  

¾ A static (persistent) IP address so that the database will be always connected to 
the client application 

¾ Proper user license – The database will only allow the purchased number of users 
to be connected at any one time to the database. Wide-Area Networks (WAN) 
require a WAN license based on the number of geographic locations. The Product 
Key is affixed to the inside cover of the CD sleeve. 

¾ CD-ROM drive or access to our software product download area on 
www.gneiltechsupport.com. 

 
Note: G.Neil cannot provide technical assistance with setting up or maintaining your 
computer network. Please consult your computer manufacturer or network administrator 
before contacting G.Neil Tech Support. 
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Client-Server Installation 
Installing a Client-Server setup is a two-step process. You will need to install to the Server 
first and then to the Workstation(s).  
 
Server Installation Instructions 
Install to the Server first by following these instructions: 
1. Insert the Optima CD on the Server. (Follow the CD Menu Instructions above.) 
2. At the Setup Type, select Server. Click Next.  
3. Select Express. Click Next.  
4. IMPORTANT STEP!: Write down the Server Name and Database Path 

EXACTLY as they appear on the screen.  
5. Click “I have written this information down.” Click Close.  
6. Click Next at the Current Settings screen. This will install the program files to the 

Server.  
7. Click Finish. This will start the installation of the database files.  
8. Click Next, then the I Agree button if you agree to the license.  
9. After the installation, click Finish.   
10. Follow the installation instructions for the Client Workstation.  
 
Note: You only have to run the Server installation once. Then you may install 
multiple clients for the Optima version purchased, or to run as a demo. 
 
Client Workstation Installation Instructions 
Install to the Client Workstation by following these instructions.  
1. Insert the Optima CD on the Client Workstation. (Follow the CD Menu Instructions 

above.) 
2. Select Client as the Setup type.  
3. Select Express, then click Next.  
4. Enter the Server Name and Database Path exactly as you wrote down from Step 4 of 

the Server Installation. Then Click Next.  
5. Click Next at the Current Settings screen. This will install the program files to the 

Server.  
6. Click Finish. This will start the installation of the needed files to run the database.  
7. Click Next, then the I Agree button if you agree to the license.  
8. After the installation, click Finish.  
9. Install the Client for any other Optima versions. (You do not have to install to the 

Server again.) You may also install to other Workstations, if needed.  
10. Double-click on the desktop application shortcut; the default Login and Password 

are ADMIN. 
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Standalone Computer Installation Instructions 
Installing to a Standalone Computer is quick and easy. Follow these steps: 
1. Insert the Optima CD on Standalone Computer. (Follow the CD Menu Instructions 

above.) 
2. Select Standalone as the Setup Type.  
3. Click on Express, then click Next.  
4. Click Next at the Current Settings screen. This will install the program files.  
5. Click Finish. This will start the installation of the database files.  
6. Click Next, then the I Agree button if you agree to the license.  
7. After the installation, click Finish.  
8. Double-click on the desktop application shortcut; the default Login and Password 

are ADMIN. 
 
Quick Note About Peer-to-Peer Installations 
A peer-to-peer connection allows you to share information between two computers 
without the need of a formal client-server connection. The peer-to-peer connection 
must be in place before following these instructions. See your Network 
Administrator for more details on setting up this type of connection.  
 
On the host computer (the one on which you wish the database to reside), follow the 
instructions above for a Server installation. Write down the Server Name and Database 
Path when prompted. Note: The Server installation will install both the software client 
application and database files to the host computer. Then install the application Client on 
the other computer that will be sharing the information, entering the Server Name and 
Database Path when prompted. 
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Chapter 3 

Company Setup  
 
 

What You Should Know About COBRA  
The landmark COBRA health benefit provisions became law in 1986. The law amends 
the Employee Retirement Income Security Act (ERISA), the Internal Revenue Code and 
the Public Health Service Act to provide continuation of employer-sponsored group 
health coverage that otherwise might be terminated.  
 
COBRA contains provisions giving certain former employees, retirees, spouses, former 
spouses, and dependent children the right to temporary continuation of health coverage at 
group rates. This coverage, however, is only available when coverage is lost due to certain 
specific events. Group health coverage for COBRA participants is usually more expensive 
than health coverage for active employees, since usually the employer pays a part of the 
premium for active employees while COBRA participants generally pay the entire 
premium themselves. It is ordinarily less expensive, though, than individual health 
coverage.  
 
COBRA Coverage 
Group health plans for employers with 20 or more employees are subject to COBRA.  
Both full and part-time employees are counted to determine whether a plan is subject to 
COBRA.  Each part-time employee counts as a fraction of an employee, with the fraction 
equal to the number of hours that the part-time employee worked divided by the hours an 
employee must work to be considered full time. 
 
Under COBRA, a group health plan ordinarily is defined as a plan that provides health 
care benefits for the employer's employees and their dependents through insurance or 
another mechanism such as a trust, health maintenance organization, self-funded pay-as-
you-go basis, reimbursement or combination of these.  
 
What Benefits Are Covered Under COBRA? 
Qualified beneficiaries must be offered coverage identical to that available to similarly 
situated beneficiaries who are not receiving COBRA coverage under the plan (generally, 
the same coverage that the qualified beneficiary had immediately before qualifying for 
continuation coverage).  A change in the benefits under the plan for the active employees 
will also apply to qualified beneficiaries.  Qualified beneficiaries must be allowed to make 
the same choices given to non-COBRA beneficiaries under the plan, such as during 
periods of open enrollment by the plan. 
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Who Is Entitled to COBRA Benefits? 
An individual must be a “qualified beneficiary” to become eligible for COBRA 
continuation coverage.  A “qualified beneficiary” is an individual covered by a group 
health plan on the day before a qualifying event (defined below) who is either an 
employee, an employee's spouse, or an employee's dependent child.  In certain cases, a 
retired employee, the retired employee's spouse, and the retired employee's dependent 
children may be qualified beneficiaries.  In addition, any child born to or placed for 
adoption with a covered employee during the period of COBRA coverage is considered a 
qualified beneficiary.  Agents, independent contractors, and directors who participate in 
the group health plan may also be qualified beneficiaries. 
 
What Is a “Qualifying Event?” 
Qualifying events are certain events that would cause an individual to lose health 
coverage.  The type of qualifying event will determine who the qualified beneficiaries are 
and the amount of time that a plan must offer the health coverage to them under 
COBRA.  A plan, at its discretion, may provide longer periods of continuation coverage. 
 
Qualifying Events for Employees:  
¾ Voluntary or involuntary termination of employment for reasons other than gross 

misconduct 
¾ Reduction in the number of hours of employment  
 
Qualifying Events for Spouses:  
¾ Voluntary or involuntary termination of the covered employee's employment for any 

reason other than gross misconduct 
¾ Reduction in the hours worked by the covered employee 
¾ Covered employee's becoming entitled to Medicare 
¾ Divorce or legal separation of the covered employee 
¾ Death of the covered employee  
 
Qualifying Events for Dependent Children:  
¾ Loss of dependent child status under the plan rules 
¾ Voluntary or involuntary termination of the covered employee's employment for any 

reason other than gross misconduct 
¾ Reduction in the hours worked by the covered employee 
¾ Covered employee's becoming entitled to Medicare 
¾ Divorce or legal separation of the covered employee 
¾ Death of the covered employee  
 
Effect of Second Qualifying Event 
Dependent beneficiaries who elect COBRA continuing coverage following the employee’s 
termination of employment or reduction in work hours are eligible to extend COBRA 
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coverage if a second qualifying event occurs causing loss of coverage.  Coverage may be 
extended for a total of up to 36 months from the original COBRA start date.          
 
How Long Does COBRA Coverage Last? 
COBRA establishes required periods of coverage for continuation health benefits.  A 
plan, however, may provide longer periods of coverage beyond those required by 
COBRA.   
 
COBRA beneficiaries generally are eligible for group coverage during a maximum of 18 
months for qualifying events due to employment termination or reduction of hours of 
work.  Certain qualifying events, or a second qualifying event during the initial period of 
coverage, may permit a beneficiary to receive a maximum of 36 months of coverage. 
 
Coverage begins on the date that coverage would otherwise have been lost by reason of a 
qualifying event and will end at the end of the maximum period (unless terminated earlier 
for reasons discussed under Early COBRA Termination, on pg 18). 
 
Maximum Coverage Periods Based on Beneficiary and Qualifying Events 

Qualified Beneficiary Qualifying Event Period of Coverage 
Employee  
Spouse 
Dependent child 

Termination 
Reduced hours 

18 months * 

Spouse 
Dependent child 

Entitled to Medicare 
Divorce or legal separation 
Death of covered employee 

36 months 

Dependent child Loss of dependent child 
status 

36 months 

* This 18-month period may be extended for all beneficiaries if certain conditions are met 
and the qualified beneficiary is determined to be legally disabled for purposes of COBRA. 
 
Extending Maximum Coverage Period due to Legal Disability 
COBRA requires group health plans to provide certain qualified beneficiaries an 11-
month disability extension of an 18-month period of COBRA coverage (resulting in a 
total of 29 months of COBRA coverage), provided the qualified beneficiary (or any other 
qualified beneficiary who is a member of his or her family) is both: (a) determined by 
Social Security Administration to be disabled during the first 60 days of COBRA 
coverage, and (b) provides notice to the plan of SSA's disability determination within 60 
days after the date of the determination. The notice must be provided before the end of 
the first 18 months of continuation coverage. 
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Early COBRA Termination 
COBRA continuation coverage may end prior to the expiration of the maximum coverage 
period if: 
¾ Premiums are not paid on a timely basis 
¾ The employer ceases to maintain any group health plan 
¾ After the COBRA election, coverage is obtained with another employer group health 

plan that does not contain any exclusion or limitation with respect to any pre-existing 
condition of such beneficiary.  However, if other group health coverage is obtained 
prior to the COBRA election, COBRA coverage may not be discontinued, even if the 
other coverage continues after the COBRA election. 

¾ After the COBRA election, a beneficiary becomes entitled to Medicare benefits.  
However, if Medicare is obtained prior to COBRA election, COBRA coverage may 
not be discontinued, even if the other coverage continues after the COBRA election.  

 
When COBRA terminates before the expiration of the maximum coverage period, the 
plan administrator is required to notify affected individuals pursuant to COBRA 
notification requirements (see below).   
 
Notifications and Timeframes 
(1) Initial Notification of COBRA Continuat on Rights.  The plan administrator 

must provide written notice to each “newly enrolled” covered employee and spouse 
of the covered employee (if any) of the right to continuation coverage provided 
under each plan. The notice must be furnished to each employee and each 
employee's spouse within 90 days of the date on which such individual's coverage 
under the plan commences (or, if later, 90 days after the plan first becomes subject to 
COBRA continuation coverage requirements).   

i

 
The COBRA regulations set forth the required minimum content of the general 
notice. These content requirements cover basic information regarding COBRA and 
the rights and responsibilities of qualified beneficiaries that a participant or 
beneficiary would need to know before the occurrence of a qualifying event in order 
to be able to protect his or her COBRA rights. 
 
New regulations clarify that a plan administrator may deliver a single notice 
addressed to a covered employee and the covered employee's spouse at their joint 
residence, provided the plan's latest information indicates that both reside at that 
address. A single notice would not be permitted, however, if a spouse's coverage 
under the plan begins at a different time from the covered employee's coverage, 
unless the spouse's coverage begins before the date on which the notice must be 
provided to the covered employee, and a single notice is then timely sent to their 
joint address. 
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Optima COBRA provides an Initial Notification of COBRA Continuation Rights, and 
reminds you to send the Notification within 90 days of adding a “newly enrolled” 
individual to a plan.     
   

(2) Notice of Qualifying Event.  The covered employee or a family member has the 
responsibility to inform the plan administrator of the following qualifying events: 
divorce, legal separation, disability, or a child losing dependent status under the plan.  
Notice must be provided within 60 days after the qualifying event.  Notice may be 
provided to the plan administrator by any individual who is either the covered 
employee, a qualified beneficiary with respect to the qualifying event, or any 
representative acting on behalf of the covered employee or qualified beneficiary, and 
the provision of notice by one individual shall satisfy any responsibility to provide 
notice on behalf of all related qualified beneficiaries with respect to the qualifying 
event. 

 
 Employers have a responsibility to notify the plan administrator of the following 
qualifying events: employee’s death, termination of employment or reduction in 
hours, or Medicare entitlement.  Notice must be provided by the employer to the 
plan administrator (if different than employer) within 30 days after the qualifying 
event. However, for any plan under which continuation coverage begins with the 
date of loss of coverage, the 30-day period for providing the notice of qualifying 
event must also begin with the date of loss of coverage, rather than the date of the 
qualifying event. 

 
(3) Notice of COBRA Qualification and Election Rights.   The plan administrator 

must furnish an election notice to qualified beneficiaries within 14 days after the 
receipt of notice of a qualifying event.  Where the employer is also the administrator 
of the plan, an election notice must be furnished not later than 44 days after the date 
of the qualifying event, or, if the plan provides that COBRA coverage starts on the 
date of loss of coverage, the date the qualified beneficiary loses coverage under the 
plan.   This applies in cases where the employer has the obligation to notify the plan 
administrator of the qualifying event (i.e., for employee’s termination, reduction in 
hours, death, or entitlement to Medicare). 

 
MyBiz COBRA generates a qualification/election notice, and reminds you to send 
the notice to each qualified beneficiary affected by the qualifying event entered.  To 
help you comply with the strict time limitations for providing the notice, MyBiz 
COBRA will indicate that your qualification/election notice is due to be sent as soon 
as you enter a qualifying event, even though you may have additional time under the 
guidelines explained above. 
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(4) Notice of COBRA Unavailability.  Alternatively, if the plan administrator 
determines that an individual is not eligible for COBRA continuation coverage, the 
plan administrator must send a notice to each qualified beneficiary explaining why 
COBRA coverage is unavailable.  This notice must be delivered within the same 14-
day window applicable to the Qualification/Election Notice. 

 
The unavailability notice must be furnished when the plan administrator denies 
coverage after receiving a notice of qualifying event, regardless of the basis of the 
denial and regardless of whether the notice involves a first qualifying event, a second 
qualifying event, or a request for a disability extension.  For example, the 
unavailability notice would be required to be provided when a plan administrator 
denies continuation coverage because it has been determined that no qualifying event 
had occurred or because the qualified beneficiary did not furnish the notice of 
qualifying event notice in a timely manner or did not provide complete information. 
 
Optima COBRA provides a notice to help you comply with this requirement.   
 

(5) COBRA Election.  COBRA allows each qualified beneficiary at least 60 days from 
the date the qualification/election notice is provided or the day health care coverage 
ends (whichever is later) to elect continuation coverage.   

 
Each qualified beneficiary may independently elect COBRA coverage.  A covered 
employee or the covered employee's spouse may elect COBRA coverage on behalf of 
all other qualified beneficiaries.  A parent or legal guardian may elect on behalf of a 
minor child.   
 
Remember, plans may allow for longer notification periods, but may not shorten 
them. To the extent that a plan provides a covered employee or qualified beneficiary 
a period of time longer than 60 days to provide notice of COBRA election to the 
administrator, the terms of the plan shall govern. 
 

(6) Notice of Conversion Rights.  Some plans allow participants and beneficiaries to 
convert group health coverage to an individual policy.  If this option is generally 
available from the plan, a qualified beneficiary who pays for COBRA coverage must 
be given the option of converting to an individual policy at the end of the COBRA 
continuation coverage period.  The option must be provided within 180 days before 
COBRA coverage ends.  The premium for a conversion policy may be more 
expensive than the premium of a group plan, and the conversion policy may provide 
a lower level of coverage.  The conversion option, however, is not available if the 
beneficiary ends COBRA coverage before reaching the end of the maximum period 
of COBRA coverage. 
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Optima COBRA generates a conversion notice and reminds you to send it within 
180 days of COBRA coverage ending.  (Note: If conversion is not available under 
your plan, you are urged to seek legal advice regarding compliance with this notice 
requirement.)     

 
(7) Early COBRA Termination Notice.  Continuation coverage may be terminated 

earlier than the end of the maximum period for many different reasons, as discussed 
above.  If COBRA coverage is being terminated before the maximum coverage 
period, the plan administrator is required to send each affected individual a notice 
indicating that coverage is ending. The notice is not required to be furnished before 
COBRA coverage can be terminated or within a specified time frame. However, it 
must be provided as soon as reasonably practicable following the administrator's 
determination that continuation coverage shall terminate. The purpose of providing a 
notice of early termination is to allow qualified beneficiaries the opportunity to take 
appropriate next steps to protect their access to health coverage, either on a group or 
individual basis. 

 
New regulations establish that the notice must include: (a) the reason that 
continuation coverage has terminated earlier than the maximum coverage period; (b) 
the date of termination of continuation coverage; and (c) any rights the qualified 
beneficiary may have under the plan or under applicable law to elect an alternative 
group or individual coverage, such as a conversion right. 

 
Optima COBRA provides a notification for COBRA termination designed to comply 
with this requirement.   

 
(8) HIPAA Certificate of Group Health Plan Coverage.  Pursuant to the Health 

Insurance Portability and Accountability Act of 1996 (HIPAA), plan administrators 
are required to provide a Certificate of Group Health Plan Coverage to individuals 
after coverage ends under a group plan. 

 
Optima COBRA generates this Certificate and reminds you to send it upon 
termination of benefits.      

 
Effective Dates of Required Notices 
By Plan Administrator:  A required notice is considered “furnished”  by a plan administrator 
as of the date of mailing (if mailed by first class mail, certified mail, or Express Mail), or as 
of the date of electronic transmission, if transmitted electronically.  When hand delivery is 
the chosen method of delivery, however, a notice would not be considered furnished until 
actually received by the individual to whom the notice is directed. 
 
By Participant/Beneficiary: In the absence of written plan procedures to the contrary that are 
communicated to participants and beneficiaries, the same standards apply to notices 
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provided by covered employees, qualified beneficiaries, and other persons acting on their 
behalf to plan administrators. 
 
Premium Payments 
Qualified individuals may be required to pay the entire premium for coverage up to 102% 
(employers may charge up to 2% as an administration fee) of the cost to the plan. For 
qualified beneficiaries receiving the 11-month disability extension of coverage, the 
premium for those additional months may be increased to 150 % (up to 50% 
administration fee) of the plan's total cost of coverage.  
 
COBRA beneficiaries remain subject to the rules of the plan and therefore must satisfy all 
costs related to co-payments and deductibles, and are subject to catastrophic and other 
benefit limits. 
 
The plan must allow participants to pay premiums on a monthly basis if requested, but 
may allow payments at other intervals (weekly or quarterly).  The plan is not required to 
send monthly premium notices to trigger payment obligation.  Failure to make timely 
payments may result in loss of coverage.  
 
The initial premium payment must be made within 45 days after the date of the COBRA 
election by the qualified beneficiary.  Payment generally must cover the period of 
coverage from the date of COBRA election retroactive to the date of the loss of coverage 
due to the qualifying event.  Premiums for successive periods of coverage are due on the 
date stated in the plan with a minimum 30-day grace period for payments.  Payment is 
considered to be made on the date it is sent to the plan (date of post-mark or hand-
delivery).  
 
If premiums are not paid by the first day of the period of coverage, the plan has the 
option to cancel coverage until payment is received and then reinstate coverage 
retroactively to the beginning of the period of coverage.  
 
If the amount of the payment made to the plan is made in error but is not significantly 
less than the amount due (less than $50 or 10%), the plan is required to notify the 
individual of the deficiency and grant a reasonable period (for this purpose, 30 days is 
considered reasonable) to pay the difference. 
 
State Laws Related to COBRA   
Many states have enacted legislation providing more favorable continuation and 
conversion options to employees than available under COBRA.   Federal COBRA 
provisions apply to all group health plans, but plans that pay benefits out of an insurance 
policy may be subject to COBRA-related state laws.  Plans operating in states with 
COBRA-related statutes should review their state laws to ensure compliance with 
conflicting provisions.    
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Before you begin using Optima  
 
Have available: 
¾ Location and Department names 
¾ User Information (Managers and other users that will have access to the data) 
¾ Employee Data Employee name, Hire Date, Work Status (full or part time), Active 

Status (Active, Inactive, or Terminated), Location and Department, Work Hours, 
Week Hours, Benefit and COBRA information 

 

Logging In for the First Time 
After installation, run the application by double-clicking the desktop application. The 
default Login and Password is ADMIN. 
 

Checklist for Setting Up  
Optima COBRA first needs some information set up to correctly track your employee 
absences; to get started, please follow the checklist below: 
 
� Change the Admin password by going to Settings, User Security. If needed, set up 

access for others who will need to continue setting up the program. If you need to 
give access to specific locations and departments, or individual employees, set these 
up first and then come back to User Security and complete security access. (See 
Chapter 3, pg 33.)  

� Set up Global Preferences. (See Chapter 3, pg 25.) 
� Create Locations and Departments. (See Chapter 3, pg 24.)  
� Set up Benefit Plans. (See Chapter 3, pg 29.) 
� Enter employee information (See Chapter 5, pg 42) and Personal Contact Info. (See 

Chapter 5, pg 50.)   
� Assign Benefits to Participants. (See Chapter 5, pg 45). 
� Add Additional Users, if needed. (See Chapter 4, pg 33). 
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Creating Locations & Departments 

 
 
Locations and Departments are required and must be assigned to each of your Employees 
(See Chapter 4 – Adding a New Employee to assign Location/Department to employees.)  
 
Note: When setting up Locations and Departments for the first time, a Location must be 
set up FIRST, and then you may assign a Department to that Location. 
 

Setting Up Locations and Departments 
Departments are assigned to Locations.  
To set up your Locations and Departments, follow these steps: 
1. Click on Locations and Departments from Settings menu.  
2. Click Locations, then click New.  
3. Enter the Location name.  
4. Click Save.  
5. Click New again to create other Locations.  
6. Click the Departments Tab, then click New.  
7. Enter the Department name.  
8. Click Save.  
9. Click New again to create other Departments that will be assigned to the Location.  
10. After all departments are created, click the + sign next to Location in the right pane.  
11. Select the assigned departments by clicking in the box next to the department.  
Note: As you add more locations and departments, you’ll see that each location has ALL 
of the departments that you’ve created. However, only those departments that you assign 
to a location will show up when assigning them on other screens. You may not remove a 
Department from a Location if an Employee is still assigned to that 
Location/Department combination. 
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Global Preferences  
To access Global Preferences, go to Settings, Global Preferences.  
 
This Global Preferences screen allows you to control your default program settings, such 
as Company Info, Report Options, and specific program options. If you are setting up for 
the first time, please follow the Checklist order.  
 
NOTE: Before editing any of the Global Settings, you must first click the EDIT button. 
 

Company Information  

  
 
The Company Information screen allows you to enter your company name, address and 
logo. The company name is required as this will print out on Reports. Having a company 
logo is recommended, but not required. If you have one, this will also print out on 
Reports.   
¾ Company Name (required for report headings) 
¾ Address, City, State, Zip and Country Code (optional) 
¾ Bitmap filename for your Company Logo (optional) If you have your company logo 

available in a bitmap (.bmp) file format, you can have this logo appear on reports. 
Records supports .bmp file formats not to exceed 200x200 in size. Enter the 
directory where the bitmap file is stored or use the Browse to locate it. 

 

Editing Company  
1. Click Edit.  
2. Enter Information as needed. 
3. To add a company logo, click Assign New Logo. Navigate to where the directory 

path is and click on the bitmap logo, then click Open.   
4. Click Save. 
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General Settings 
The General Settings Tab allows you to set the program defaults such as the Epoch 
setting, default hours in a day, and SSN format, among others. 
 

 
 
¾ Epoch Setting – We strongly recommend keeping the default settings. This setting 

will allow the program to appropriately interpret any two-digit year entered that is 
between 1920 and 2019. For example, with the default Epoch setting of 1920:  
♦ If you enter a date (such as in the Hire Date field) of 03/05/78, the program 

will interpret this as 03/05/1978.  
♦ If you enter a date of 03/05/01 within the program, it will be interpreted as 

03/05/2001.  
Note: If you need to enter a year prior to 1920 or after 2019 in a date field within the 
program, you may enter the year as a four-digit number.  
¾ Default Hours in a Day – These are the default hours that will be assigned when 

creating a new employee. The Day Hours on the Employee Detail screen will be 
filled in automatically with these default hours when a new employee is created.  

¾ National ID Number Format /Label – Selecting one of these options will allow 
you to set the mask for the National ID Number Format. The default mask is set to 
the USA SSN format. With this selected, whenever you enter a new employee, the 
dashes will automatically come up in the xxx-xx-xxxx format. The label is the title 
that will appear on the Employee Detail screen (SSN by default). 

¾ Allow Use of Forgotten Password Utility – This option allows access to a utility 
that can be used, only with assistance from G.Neil Tech Support, to gain access into 
the Optima program. In order to use this feature, we require that a statement on a 
company letterhead and signed by a supervisor, be sent by fax or mail stating that the 
user is allowed full access into the program. We keep statements on file. Call G.Neil 
Tech Support if you have forgotten or lost your Optima password. 
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¾ Forced Writes for Interbase – If running the Optima database on a Standalone 
computer, this option will help to keep the database more stable. A Workstation is 
more prone to lock up or crash than a Server. If the Optima database is installed on a 
Workstation and the program is open at the time the computer locks up or crashes, 
the database is prone to becoming corrupt and possibly unrepairable. A computer 
lockup or crash can be attributed to several things, including having too many 
programs open at the same time than what your computer memory can handle.  

¾ Note: If the database is installed on a Workstation or Standalone computer, we 
recommend keeping this option checked. The performance may lag a little, but unless 
you have more than 800 employees, you may not even notice it. We also recommend 
having a current backup, created within Optima or DB Monitor, available. If the 
database is installed on a Server, normally a backup of the whole Server is created on 
a daily or regular basis. We still recommend setting up Scheduled backups within DB 
Monitor, but having this option checked is not as important on a Server. 

¾ Prompt for Backup on Exit – This option allows you to turn on or off the message 
prompting for backup when you close out of the program. Backups are very 
important. We recommend that you turn this feature off only if you have scheduled 
backups within the DB Monitor. 

 

Report Options Tab  

 
 
These settings affect how reports will appear by default.  
¾ Print Preview – Toggles (turns on and off) showing preview first before printing 
¾ Header Bold – Toggles bolding for Header Title 
¾ Header Line – Toggles putting a line under the Header Title 
¾ Header Shade – Toggles shading for Location or Department title row 
¾ Data Lines – Toggles lines to separate data information 
¾ Print SSN – Toggles ability to show Social Security Numbers  
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¾ Print Picture – Toggles ability to print Picture on printout 
¾ Print Totals – Toggles whether or not Totals show up on reports 
 

COBRA Tab  
It is important that you enter all requested information in the area titled “COBRA 
Administrator” under Global Preferences > COBRA Tab before getting started.  Failure 
to do so may prevent your COBRA Notifications from generating, and may interfere with 
other important COBRA administration features. 
 

 
 
The COBRA tab has the following options: 
 
Administrative fee to be charged to COBRA Participants 
Use fees from Plan Rate Tiers – If checked this option will use the Admin fee rates from 
a specific Plan's Rate Tier, otherwise, if unchecked, rates will be used from here.  
 
Regular % – Regular admin fees can be up to 2%. 
Disabled % – This admin fee can be up to 50%. 
 
Default for To Do List days out 
Displays the To Do List this many days out according to the number entered here. 
 
COBRA Administrator  
Enter the info as needed for the COBRA Administrator. 
 

Other Optima Tabs  
Additional Optima programs must be installed for these options to display. See the 
appropriate manual for setting up these options. 
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Setting up Benefit Plans  
Benefit Plan Maintenance is where you will create and set up benefit plans. You do not 
assign the plans to employees from here. Benefit Plans are assigned to employees from 
the Benefits feature.  
 

 
 
To set up Benefit Plans, follow these steps: 
1. From Settings, Benefit Plan Maintenance, click New.  
2. Fill in information as needed. 
3. Click Save. 
 
Benefit Plan Maintenance has the following options: 
¾ Type – Types include general category types such as 401k, COBRA, Medical, Dental, 

etc. and are set up from Settings, General Codes, Benefit Plan Types. 
¾ Plan Name – Plan names should be more specific, such as “Medical – Self” or 

“Dental – Dependent”. 
¾ Insurance Company Name – Name of the insurance company for the selected type. 
¾ Telephone Number (Customer Service) – Number that can be reached in case you 

have questions. 
¾ Street Address 1 and 2 – Mailing address of insurance company. 
¾ City, State, Zip – Mailing info of insurance company.  
¾ Open Enrollment Effective Month – Month when plan permits open enrollment 

(typically January of each calendar year). 
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¾ Termination Cycle – Options are End of Month or Immediate. If the plan terminates 
coverage on the actual date of a qualifying event, such as an employee’s termination 
date, enter “Immediate.” If the plan allows coverage to run until the end of the 
calendar month during which the qualifying event occurs, enter “End of Month.”  It 
is extremely important that you enter this information accurately. 

¾ Minimum Week Hours – Number of hours needed to qualify for coverage under the 
plan. 

¾ Dependent Age Cap – Upper age limit allowed for dependents to receive plan 
coverage.  Enter the plan’s age cap for Students and Non-Students. 

¾ Require Beneficiaries – Select this option if plan type requires beneficiaries. This 
option will display the Beneficiaries button when assigning this plan to participants 
(employees, dependents, etc.).  

¾ Employee Only Benefit – Select this option if plan type is only for the employee and 
not for dependents or other.  

¾ Enable COBRA for this plan - Select this option if you want COBRA options to be 
associated with this plan. The COBRA icon will be available on the Employee 
Benefits feature. It is important for you to accurately designate whether a plan is 
COBRA-eligible.  By law, most plans are deemed COBRA eligible.  However, short-
term and long-term disability plans, workers’ compensation coverage, and wellness 
plans generally are not COBRA-eligible.  Life insurance plans are only COBRA-
eligible if required by state law.   

 
The following plan types generally are required to offer COBRA continuing  
coverage: 
• Preferred Provider Organizations (PPOs) 
• Health Maintenance Organizations (HMOs) 
• Exclusive Provider Organizations (EPOs) 
• Medical Indemnity Insurance Plans 
• Dental Indemnity Plans 
• Prepaid Dental Plans 
• Prescription Drug Plans 
• Substance/Alcohol Treatment Plans 
• Free-standing Psychiatric Plans 
• Vision and Hearing Plans 
• Long-term Care Plans; and  
• Section 125 Medical Reimbursement Accounts 

     
¾ Plan Terminated – If selected, this plan will not show up on drop-down options 

where you need to select benefit plans. 
¾ COBRA Billing Options gives you a choice between Billing Monthly or Using 

Coupons. If you select Bill Monthly, bills will be generated on a monthly basis. If you 
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select Use Coupons, bills will be generated through the end of the benefit year. The 
benefit year is based on twelve months beginning from the Open Enrollment 
Effective Month (Benefit Plan Maintenance). For example, if your Open Enrollment 
Effective Month is January, billing records through December will be created. Note: 
billing records for the next benefit year will be created approximately 25 days before 
the end of the current benefit year. 

¾ Rating Tiers – some plans may have different rate options for the same plan, such as 
Single, Single +1, Family, etc. Clicking New will allow you to add different tier levels. 

¾ Rate Effective Date - This is the date the Rating Tiers are effective from. 
¾ Tier # – The program automatically numbers the tiers as they are created. 
¾ Tier Name – Name should be specific to the plan tier such as: Med – Self I, Med – 

Self II, Med – Self III.  
¾ Rate – This is the dollar amount that is paid to the insurance company. 
¾ Apply Contribution as % - This toggles whether the Employer Rate and Employee 

Rate will be entered as a dollar amount ($) or percentage (%). 
¾ Employer Rate – The rate the employer pays. Can be a dollar amount or percentage 

depending on option for Apply Contribution as %.  
¾ Employee Rate – The rate the employee pays. Can be a dollar amount or percentage 

depending on option for Apply Contribution as %. 
¾ Regular Admin Fee – This must be entered as a percentage (%), even if contribution 

rates are set up in dollars ($).  
¾ Disabled Admin Fee - This must be entered as a percentage (%), even if contribution 

rates are set up in dollars ($).   
¾ Comments – Add any relevant notes in the comments field.  
 

Setting up COBRA Notifications  
Optima COBRA provides several types of customizable notifications. The notifications 
are grouped under the following categories:  
 
Newly Enrolled Billing COBRA Termination 
Qualification/Election Rate Change HIPAA 
Conversion Insufficient Payment COBRA Unavailability  
 
(For more information about the purpose, content, or timing of these notifications, see 
Chapter 3 – Notifications and Timeframes under What You Need to Know About 
COBRA.) You can print the notifications from the Reports Menu.  
 
Optima COBRA notifications are attorney-developed and designed to comply with 
current COBRA Regulations.  If you wish to make content modifications, you are urged 
to have them reviewed by counsel to ensure compliance. 
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When making changes be aware that items in brackets, such as [NOTICEDATE] are field 
names and should not be changed. These items are fields that are pulled from the 
database.  If items in brackets are modified, the application will not be able to filter 
information automatically from the database to the notification.  
 
To customize a notification, follow these steps: 
1. From Settings, Cobra Notification, select a notification then click Edit.  
2. Make changes as needed. 
3. Click Save.  
 
Once you change a notification under Settings, the new version will automatically be 
generated each time you use the notification. To make a one-time modification that isn't 
saved as a template, you may modify an individual notification at the employee level when 
viewing/printing notifications instead of using Settings (see Chapter 3 – Viewing/Printing 
COBRA Notices).    
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Chapter 4 

Security Options 
 
 
Due to the confidential nature of information stored in Optima, security is always turned 
on. This will help prevent unauthorized persons from accessing critical employee data. 
The use of security is required, and setting up access to Optima and any other G.Neil 
applications you have should be completed right after you set up Locations and 
Departments.  
 

Frequently Asked Questions 
What is a user? 
Simply put, this is the person using the program. They may be entering or viewing data. 
The Administrator may set specific access to only those features a user will need access to. 
 
How many different users can be set up? 
The security file can contain a list of as many users as you desire. For example, each user 
would have their own login name and password with access rights to specific features. 
 
Can I set up each user to view only his or her own employee information? 
Yes. (See this chapter – Setting Up Access to Locations, Departments and Individual 
Employees.) 
 
If I use other Optima programs, will users need to be entered again? 
Optima Attendance, Records, Time Clock and COBRA share the same security file so if 
you are using these programs, there is no need to enter basic information twice. 
 
I have a Single User License, but want three other users to access the program; 
how many computers may I put the program on with a Single User License? 
The Optima applications are single user licenses and can only be installed on one 
computer. If you need more flexibility and need to install to a network environment we 
recommend checking out our Optima applications which allow networking.  
 
Common Features 
Features under the User Security Features Tab are shared among Optima Attendance, 
Records, Time Clock and COBRA. For instance, Locations and Departments are 
common to all three programs, as are Global Settings. Even if you only have one of the 
listed programs, you will need to follow these instructions to set up user access rights. 
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Note: You will not see the program tabs for programs that are not installed.  
 
Detail Tab (Common Features) 
¾ Search For – This allows you to search by User Name. 
¾ Save As – This allows you to create additional users based on the access rights of 

another user.  
¾ Employee Record Access – This allows access to view, add or delete employee 

records.  
¾ Employee Detail – This grants access to the Employee Detail screen. 
¾ View SSN – This allows access to view Social Security Numbers.  
¾ Run Reports – This allows access to run reports.  
¾ Reminders – This allows access to add and delete reminders.  
¾ Reminders, Assign Global – This allows access to assign reminders as Global.  
¾ Reminders, Assign Users – This allows access to assign reminders to other users.  
¾ User Security – This allows access to add, edit, and delete users and user access.  
¾ Location/Department Maint – This allows access to assign location/department 

access for users.  
¾ Global Preferences – This allows access to edit global preferences.  
¾ Database Monitor – This allows access to the DB Monitor.  
¾ Database Backup – This allows access to Backup from the DB Monitor.  
¾ Database Restore – This allows access to Restore from the DB Monitor.  
¾ Alter Product License – This allows access to change one or more Product License.  
¾ Conversion – This allows access to run the Conversion Utility.  
¾ Custom Reports – This allows access to create/modify Custom Reports. 
¾ Import Data – This allows access to import employee data into the database. 
¾ Export Data – This allows access to export employee data. 
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Setting up access to common features (Detail Tab) 
1. Click New from the User Security, Detail screen.  
2. Enter a Log In and Password (letters and numbers only) and the user’s Full Name.  
3. Select options for Displaying Reminder Alarms and Hints for this login.  
4. Select Yes to allow the user to begin logging in after giving access. Setting this option 

to NO is a good security measure when users are out of the office for a number of 
days.  

5. Select what type of Feature Access users will have by clicking in the Feature Access 
Rights block.  

6. Clicking on the arrow will allow you to select from the following:  
¾ NO ACCESS – no access to selected feature 
¾ READ ONLY – allows user to view only; cannot make any changes 
¾ READ WRITE – allows user to view, add, and edit; no deleting allowed 
¾ READ WRITE DELETE – allows user full editing rights to feature 
¾ YES – allows access to feature 
¾ NO – no access to feature 

7. Click Save. 
 
Setting up access to specific program features 
Once the above steps are completed, follow these steps to set up access to specific 
program features: 
 
1. From Settings, then User Security, click on the Records Tab.  
2. Select what type of Feature Access users will have by clicking in the Feature Access 

Rights block until a drop-down arrow shows up. Clicking on the arrow will allow you 
to select from the following: 
a. NO ACCESS – No access to selected feature 
b. READ ONLY – This allows user to view only; cannot make any changes 
c. READ WRITE – This allows user to view, add, and edit; no deleting allowed 
d. READ WRITE DELETE – This allows user full editing rights to feature 

3. Click Save. 
 
Program Features (COBRA)  
¾ Show COBRA Tab – Selecting “YES” for this option will display and allow access to 

the COBRA program. 
¾ COBRA Billing – Allows READ, WRITE and/or DELETE access to this feature. 

COBRA Billing is accessed from the main features. 
¾ COBRA Tasks – Selecting “YES” allows access to this feature. COBRA Tasks are 

accessed from the View Menu.  
¾ COBRA – Allows READ, WRITE and/or DELETE access to this feature. COBRA 

is accessed from the Benefits feature.  
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¾ Benefits – Allows READ, WRITE and/or DELETE access to this feature.  Benefits 
is accessed from the main features. 

¾ COBRA Notices - Allows READ, WRITE and/or DELETE access to this feature. 
COBRA Notices are accessed from the main features. 

 
Setting Up Access to Locations, Departments and Individual 
Employees 
You should have already set up your Location and Department names (see Locations and 
Departments). Now you will want to set up users’ access to the Locations and 
Departments by following these steps:  
1. Click on Location/Department Tab from Settings, User Security, Detail.  
2. Click on the “+” (plus sign) next to Locations/Departments and next to the location 

and department name to expand the list.  
3. Click in the box next to the location and department name to select access to these 

areas or individual employees within these departments. This will put a checkmark in 
the box. Click in the box again to unselect.  

4. If you have already entered your employees in the program and assigned location and 
departments to them, when you expand a department, you will see all the employees 
assigned to that location/department combination. You may then select access to 
individual employees at this point by clicking in the box next to the employee. Note: 
If you haven’t entered your employees (through the Employee Detail feature or 
Import Data under the File Menu) into the program, you will still be able to assign 
access to a location/department combination, just not down to the employee level. 
You may later assign access down to the employee level after you enter your 
employees and assign a location/department to them.  

5. Click Save. 
For instructions on setting up user access to any other G.Neil program (e.g., Attendance, 
Records or Time Clock), please see Security Options in the appropriate user manual.  
 

Forgotten Password Feature 
The program has a Forgotten Password feature that can be used in case of forgotten or 
lost passwords. Please follow these instructions in this case: 
1. Fax a statement on your company letterhead, to our Technical Support Department. 

The statement should be signed by a manager or supervisor, authorizing you to have 
a password that allows full access to the security feature within the program. (See 
Chapter 8 – Contacting Technical Support for our Support Fax number.) Example 
Statement: (authorized name and title) is authorized to have full access to the (name 
of program). Signed by (supervisor name, title and contact information).  

2. Once the Fax is sent, contact our Technical Support Department at the phone 
number in Chapter 8. Please have the program opened to the Login/Password 
screen. The representative you get in contact with will walk you through the next few 
steps to get you back into the program. 
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Chapter 5 

Managing Employee 
Records 
 
 
This chapter will help you become acquainted with the program layout and how to enter 
employee information. Throughout this chapter there are examples of different program 
screens. You may wish to view the sample database to get a better picture of how 
employee records look once entered. (See Chapter 8 – Sample Database for more details.) 
 
Make sure you have gathered the following information for each employee before 
attempting to enter employee records: 
 
¾ Social Security Number 
¾ Name (First, Middle, Last)* 
¾ Employee Identification Number 
¾ Date of Hire* 
¾ Job Title 
¾ How many hours in a day the employee works* 
¾ Location* 
¾ Department* 
¾ Full or Part-time* 
¾ Active, Inactive or Terminated Status* 
* - Required data 
 

Using Optima   
Optima is now easier to navigate than ever before. Even better, if you have other Optima 
software installed, such as Optima Attendance and Time Clock, you have access to all 
programs and features from one convenient interface.  
 
The main parts of the Optima user interface are the Menu Bar, Program Bar, Feature 
Column, Employee Select Column, Selected Feature Pane and the Recent Features Pane. 
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Pane 

 
 

The Menu Bar 
File Menu 
Maintenance 

Backup Database – This lets you perform a database backup while running the 
program. 

Import Data – Imports basic employee data into the Optima database.  
Export Data – Exports basic employee data from the Optima database. (See Chapter 10 
Import  and Export.) 
Delete Employee – Deletes an employee from the Browse or Employee Detail screens. 
Note: This cannot be undone and deletes all data for the selected employee! 
Exit 
MRU list – (Most Recently Used list) Allows you to quickly select an employee by 
clicking on his or her name 
 
View Menu 
Filter Page – Gives other options for sorting and filtering, such as hiding terminated or 
inactive employees. 
Open Reminders – Brings up all open reminders (those not checked as resolved).  
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Checklist – Displays Checklist screen that helps you set up the program. You may select 
"I am finished with the Checklist" to not display the Checklist on start up. You may 
access this screen again by going to View, Checklist.  
Welcome – Displays initial Welcome screen that pops up when you first run Optima. 
You may  select "Don't Show this Message Again" to not display the Welcome screen the 
next time on start up. You may access this screen again by going to View, Welcome.  
 
Settings Menu 
User Security – Allows you to set user access to features, locations/departments and 
employees  
Global Preferences – Allows you to set program preferences such as Company Info, 
Report Options and other program options 
Locations/Departments – Allows you to add/edit locations and departments and 
assign departments to a location 
Benefit Plan Maintenance – This is where you set up your Benefit Plans before they are 
assigned to employees. (See pg 29, Setting Up Benefit Plans, and pg 45, Assigning Benefit 
Plans to Employees.) 
COBRA Notifications – After setting up your Benefit Plans, you can review and edit the 
COBRA Notices as needed.  
 
Reports Menu  
Previews and prints up several reports; you can also access this list and select a report by 
clicking Reports on the left Feature Column.  
 
Help Menu 
Contents – Brings up the Help File 
System Information – Displays database information and current users 
About – Displays program version number and current license 
Alter Current Product License – Allows you to enter/edit product key code 
 

The Program Bar 
The Program Bar allows you to select the Optima program you wish to use and displays 
its features in the Feature Column. The programs are color-coded as follows: Optima 
Attendance – Green; Optima COBRA – Red; Optima Time Clock – Purple; Optima 
COBRA – Light Blue.  
 

The Feature Column 
The Feature Column allows you to select which feature will be displayed in the Feature 
Pane on the right side. To make it easier, we also color-coded the features of each 
program. For example, if you select Optima COBRA, and select Employee Detail from 
the feature column, you will see a light blue title bar.  
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The Employee Select Column 
The Employee Select Column allows you to select or find employees quickly and easily, as 
well as select multiple employees for printing reports.  
 
Browse mode allows you to perform an incremental search for an employee, move 
columns and sort quickly.  
An incremental search allows you to enter the first couple of letters of the employees’ last 
name and will go to the first employee which matches those letters; and as you enter more 
letters, the search will become more defined. For example, if you enter the letter “A” in 
the Search field, the employee list will select the first employee name which starts with the 
letter “A.” If you enter the letter “d,” so that now you have “Ad” it will bring up the first 
employee name which starts with Ad, such as Adams. 
 
You may move columns according to your preferences. To move a column, click and drag 
the title to the left or right. Double arrows pointing inward will show you where you will 
drop the title if you release the mouse button. 
 
Sorting fields is just as easy. Just click on the title of the column you want to sort. For 
example, if you wanted to sort by first name, you would click on the First Name title. You 
can also set multiple sorts by holding the CTRL key and clicking on fields; the sort 
priority will be displayed above the field names. 
 
TreeView mode allows you to find or select employees by location and department. For 
example, if you were looking for employees who are under the Ft. Lauderdale location / 
Merchandising department, TreeView mode could show you at a glance.  
 
Tip: In TreeView, by default all locations and departments are unchecked. A quick way to 
select just one department is to click on the name of the department. This will select all 
employees under that department. Likewise, in Browse mode, you can select or deselect 
all employees by clicking on the red checkmark at the top left. 
 

Selected Feature Pane 
The Feature Pane is where the selected feature of the program will be displayed. Note: 
Columns can be resized. To resize a column, move your cursor to the left or right edge of 
the column until your cursor turns into a double arrow pointing left and right; click and 
drag your left mouse button to the desired width and release. The Employee Select 
Column can also be hidden and unhidden by clicking on the minus or plus sign in the top 
right corner. 
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Recent Features Pane 
This is a list of the most recently used features. Clicking on a feature from this list will 
bring it up in the Feature Screen. It’s a quick way to get back to a previous screen. 
 

Employee Detail Feature  
The Employee Detail Feature is the main data entry and viewing screen for employee 
information. It is shared between the Optima versions of Records, Attendance and Time 
Clock. If only one program has been installed, the features for the others will not be seen. 
The screen is divided into two sections, the search and browse view on the left, and the 
main data entry screen on the right. Note: Pictures are assigned to an employee through 
the Edit Picture button under the Personal Contacts or Employee Detail Feature. 
 

 
 
¾ Salutation: Select Mr., Mrs., Ms., as appropriate; this field is not required. 
¾ First: Enter employee’s First Name.  
¾ MI: Enter the first letter of the employee Middle Name (Middle Initial). 
¾ Last: Enter the employee’s Last Name. 
¾ SSN: Employee’s Social Security Number (or other National ID as selected under 

Global Preferences, General Settings) 
¾ ID: Enter a unique ID for the Employee. 
¾ Hire Date: Enter the date the employee was hired. If the employee has been hired 

more than once, you should enter the last (most recent) hire date (required for 
accuracy of HIPAA Certificate).   

¾ Work Status: Select Full-time or Part-time as appropriate. 
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¾ Employment Status: Select Active, Inactive, or Terminated to show the employee’s 
status. 

¾ Job Title: Enter the employee’s current Job Title. 
¾ Location:  Select the location at which the employee is primarily employed. 
¾ Department: Select the Department that the employee is currently assigned to. 
¾ Day Hours: Enter the number of hours the employee will work in a typical workday. 
¾ Week Hours: Enter the number of hours the employee will work in a typical 

workweek. 
¾ Hide Picture: Click in this box to hide the assigned picture. To assign a picture, see 

the Edit Picture button under the Personal Contacts Feature. 
 
Adding a New Employee 
1. Click the New icon or select Edit and New Employee from the main menu. Click 

Next button after entering data for each screen. 
2. Enter the Required Fields. (You can use the TAB key to move from field to field or 

hold down the SHIFT key and press TAB to move back a field.) 
3. Required Fields -  

a. First and Last Name 
b. Hire Date 
c. Work Status 
d. Employment Status  
e. Location 
f. Department 
g. Hours (Day and Week) - This is the amount of hours an employee 

works for a typical workday and workweek. These numbers are used 
as defaults when generating report totals. 

 

Benefits Feature 
 
NOTE: You’ll need to have your Benefit Plans set up from the Settings Menu > 
Benefit Plan Maintenance option before you can assign Benefits to employees.  (See 
Chapter 3 – Setting up Benefit Plans for more info on setting up.) 
 
The Benefits feature allows you to assign and track benefits, such as 401(k), COBRA, 
FMLA, dental, medical, life insurance, disability and others for employees. 
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New -  
Assigns a benefit to 
participants under this 
employee. 

Edit / View -  
Review or edit existing 
benefits 

COBRA Event -  
Creates COBRA events 

Benefits Feature 

Grid -  
Displays 
existing records 
for selected 
employee 

 
The main Benefits screen has the following options: 
 
Buttons 
New – Allows you to assign benefits to participants under the selected employee  
Edit/View – Allows you to edit and/or review existing benefit options 
Delete – Deletes the selected benefit and any COBRA records associated with it. NOTE: 
Deletions are permanent.  
Print –  
Help – Brings up the help file associated with this screen. 
COBRA Event – Allows you to create a COBRA event associated with the selected 
benefit.  
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Benefit Detail 
¾ Effective Date – This is the date when the employee first becomes covered under the 

plan. 
¾ Type – Lists the type of plans available (i.e., Medical, Vision, Dental, 401k, etc.) 
¾ Plan – Lists the type of plans listed according to the Type selected. (For example, if 

you selected Medical as the Type, then you would only see Plans that were under 
Medical Type.  

¾ Rate Tier – Lists the rate tiers associated with the selected Plan. 
¾ Waived this benefit – If selected, this marks the benefit as being waived by the 

employee. NOTE: If a participant, other than the employee is taken off the plan, you 
should unselect them from the Participants table.  

¾ Use Rates from Tier – If checked, the program will use the Rate Tier from the 
selected Benefit Plan, otherwise, you may manually enter this information. 

¾ Coverage End Date – Date when the individual’s coverage actually ends.  Do not fill 
in a date unless you are actually terminating the individual’s coverage under the plan. 

¾ Participants – The Participants Grid will display Personal Contacts marked as Spouse 
or Partner and all dependents. A checkmark in the Selected column designates 
participants on this plan. The Creditable Coverage Date is filled in manually and is 
the date the specified employee started coverage. 

¾ Creditable coverage date - Date when individual first had coverage for HIPAA 
purposes. 

¾ Comments – Enter relevant comments. 
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History Tab 
The Benefits Detail History tab displays a record of Benefit changes. 
Clicking EDIT will open the details for the selected benefit, and NEW will allow you to 
create a new benefit.  
 

Assigning a Benefit Plan to an Employee 
Benefits need to be tracked whether an employee elects to participate in a benefit plan or 
even if they waive the benefit. Optima COBRA allows you to track both of these events.  
 
To assign a benefit event to an employee, follow these steps: 
1. From the Benefits Feature screen, click New.  
2. Enter the Effective Date of this Plan. 
3. Select the Benefit Type, Plan, and Rate Tier. 
4. Select whether to use the Plan Rate Tiers or enter rates manually. 
5. Select the participants who will be taking part in this benefit plan. 
6. Enter the Creditable Coverage Date. This is the date of initial coverage (for HIPAA 

purposes) - which may be earlier than the plan's "effective date" if the individual was 
covered under a previous plan. 

7. Save your changes. 
 

Waiving a Benefit Plan  
If an employee elects to waive a benefit, it is marked by following these steps: 
1. From the Benefits Feature screen, click New.  
2. Select the Benefit Type, Plan, and Rate Tier. 
3. If participants are waiving this benefit, select the Waive checkbox. 
4. Enter the Date Effective. 
5. Save your changes. 
 

Creating a COBRA Event  
The COBRA feature allows you to track COBRA-related information , beginning with the 
“qualifying event” resulting in loss of coverage. Qualifying events typically associated with 
COBRA are: Employee Termination, Reduction in Hours, Employee Death, Divorce or 
Separation, Medicare Entitlement, Loss of Dependent Status, and Legal Disability. (See 
Chapter 3 – What You Should Know About COBRA).   
 
NOTE: You’ll need to have your Benefit Plans set up from the Settings Menu > 
Benefit Plan Maintenance option before you can assign COBRA benefits to employees. 
(See Chapter 3 – Setting up Benefit Plans for more info.) 
 
To create a COBRA Event, follow these steps: 
1. From the Benefits Feature screen, click the COBRA Event button, then New. 
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2. Select the type of Qualifying Event from the drop-down box.  
3. As you enter more information more fields will become available to fill in.  
4. The Must Respond By date, Plan type and Plan Name will be filled in automatically, 

as will the Monthly Rate, Participants and COBRA Expiration date.  
5. Click Save when completed.  
The main screen for COBRA has a grid format with the following information: COBRA 
Event, Plan type, Plan Name, and Event Date.  
 
Clicking Edit will open the details for the selected event, while New will allow you to 
create a new event. 
 
The COBRA Feature has the following options: 
¾ Qualifying Event – This refers to the event or circumstance causing coverage to end 

and triggering COBRA continuation coverage. Qualifying events typically associated 
with COBRA are: Employee Termination, Reduction in Hours, Employee Death, 
Divorce or Separation, Medicare Entitlement, Loss of Dependent Status, and Legal 
Disability. (See Chapter 3 – What Is a “Qualifying Event?” under What You Need to 
Know About COBRA.)   

¾ Event Date – Date of event, such as termination date, date of reduced hours, etc. 
¾ Initial Event? – Do not select if this is a second qualifying event (See Chapter 3 – 

Effect of Second Qualifying Event  under What You Should Know bout COBRA.)   
¾ Benefit Ending Date – Expiration date of benefit. 
¾ Qualification/Election Sent – Date when plan administrator sends 

qualification/election notice.     
¾ Must Respond by date – This date will automatically fill in according to the program. 
¾ Response Date – Date that a response was received. 
¾ Response – Type of response received. (Accepted, Waived, etc.) 
¾ COBRA Unavailable – This option should be used when you determine that an 

individual is not eligible for COBRA continuation coverage.  COBRA regulations 
require you to notify individuals if COBRA coverage is not available to them. (See 
Chapter 3 – Notifications and Timeframes).  If you determine that COBRA coverage 
is unavailable, insert a check next to “Generate Unavailability Notice” to create the 
required notification.  For more information on the use of this notice, click “Help on 
Unavailability Notice.”    

¾ Plan Type – This will automatically fill in according to the type of plan assigned.   
¾ Plan Name – This will automatically fill in according to the type of plan assigned.  
¾ Plan Tier – Tier(s) that is available to the participants according to the benefit plan.  
¾ Fee Type – Allows you to choose between Regular or Disabled for the Fee Type. 
¾ Monthly Rate (Including Admin Fee) – Field will be filled in automatically according 

to the benefit plan. Clicking the checkbox for Override Fee will allow you to 
manually change this amount.  

¾ COBRA Start Date – Beginning date of COBRA coverage. 

    46   



 

¾ Subscriber (Bill Payer) – Lists the available names to choose from. These are the 
names that are entered in Personal Contacts.  

¾ COBRA Participants – Eligible participants will automatically populate this area. 
Participants are taken from the assigned Benefit Plans in the Benefits Feature. Note: 
To add Participants, or to create separate or individual elections, return to the 
Benefits Detail screen.  

¾ COBRA Expiration – Will be filled in automatically according to the benefit plan. 
¾ Override Expiration Date – Allows you to change the COBRA Expiration date 

manually. 
¾ Actual COBRA Ending – This date may differ from COBRA Expiration date if 

COBRA is terminated before maximum coverage period (See Chapter 3 – Early 
COBRA Termination  under What You Should Know About COBRA.)   

¾ Reason for Ending – Important for early COBRA termination. 
¾ Comments – Add relevant notes for this event. 
 

Viewing/Printing COBRA Notices  
The COBRA Notices Feature shows, at the employee level, the status of notices whether 
they're becoming due soon (green or yellow), overdue (red) or have been printed.  
 
The categories of notices that can be printed are: 
¾ Newly Enrolled   
¾ Qualification/Election 
¾ COBRA Unavailability 
¾ Conversion 
¾ Billing 
¾ Rate Change 
¾ Insufficient Payment 
¾ COBRA Termination 
¾ HIPAA 
(For more information about the purpose, content, or timing of these notifications, See 
Chapter 3 – Notifications and Timeframes under What You Need to Know About 
COBRA.) 
 
Once you print a notification, the notification is automatically saved with the date and 
time of printing.  This becomes a record of when you sent the document and what it 
included.  You may not save the document without first printing it.   
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COBRA Billing Feature  
COBRA Billing records are automatically created when a COBRA event is recorded. You 
can create new bills or edit existing amounts by clicking on the New or Edit button 
respectively, however, we recommend having the program automatically create the 
records from the COBRA event.  
 
 
 
 

 

Payment - 
Allows you to enter payments 
and view history. 

New - 
Allows you 
create a manual 
bill payment. 

Edit - 
Allows you to manually 
change a bill payment 

COBRA Billing 

Grid -  
Displays 
existing records 
for selected 
employee 

 
The main COBRA Billing Feature is in a grid format and has the following options: 
¾ Payment – Allows you to apply received payments against bills.  
¾ New – Allows you to create a manual bill payment. We recommend having the 

program create the bills automatically, which is done after a COBRA event is created, 
however, the ability to create a manual bill is there if needed.  

¾ Edit – Allows you to edit an existing record. Again, we recommend having the 
program create the bills automatically, however, this ability is there if needed. 

¾ Print – Prints the COBRA Billing Report on the amount due and how much was 
paid.  

¾ Help – Brings up the help file associated with this screen. 
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Receiving a Payment 
This is the screen that comes up after clicking the Payment icon.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Show / Hide History 
Select Record to 
view or edit 

Amount applied 
to payment 

Amount due after 
payment has been 
applied 

Will always show 
selected record 
and any payments 
due 

Selected (checked) 
payments to apply 
received amount to 

Full amount due 
for that month 

Amount left over from 
received amount, if any, 
after payment has been 
applied,  

Received Amount

To receive a payment follow these steps: 
1. Select the appropriate employee, then select COBRA Billing. 
2. Click Payment. When you enter the Payment screen, it will be in Edit mode (you can 

start entering your data). If you click on the Show/Hide History button, you'll need 
to press the Cancel button to get out of Edit mode, otherwise, you'll get a message 
stating, "An amount is required. Please enter an amount or cancel your changes." 

3. In the Amount field, enter the amount of the received payment. 
NOTE: If the amount received is equal to or less than the first record's Bill Amount, the 
amount received will be applied to the first record. If the amount received is more than 
the first record, with multiple records displaying, then the amount received will be applied 
to the first record and then to the second record until the full amount received is used. 
You may manually set which records to apply the amount received to by clicking on the 
checkbox and entering the amount manually in the Payment Amount field.  
4. Enter a Reference Number, if needed. 
5. Enter the Receipt Date. 
6. Enter the payment Type. (See Payment Types below for more info.)  
7. Apply the amount received to a record(s), if needed.  
8. Click Save. 
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Payment Types: 
Payment types are just to record the type of transaction. They do not adjust balances. 
Cash 
Check 
Money Order 
Credit 
Adjustment 
 
Reviewing/Editing a Payment from History  
The Payment History feature allows you to review receipts and edit payment amounts as 
necessary.  
 
To edit a payment from history, follow these steps: 
1. From COBRA Billing Feature, click Payment and then Show/Hide History. 
2. Click Cancel to take the program out of EDIT mode. When you first come into the 

Payment screen, it always starts in EDIT mode. To edit a record other than the first 
one, you'll need to take it out of EDIT mode by clicking Cancel. 

3. From the grid (left side) select the record you want to change.  
4. Enter the new amount in the Amount field on the right side. 
5. Make any other changes as necessary. 
6. Click Save.  
 

Personal Contacts Feature   
The Personal Contacts Feature allows you to add and edit dependent contact information.  
The main screen is in a grid format and allows you to quickly locate contact information 
for an employee.  
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The first Relation listed will always be the selected employee. This helps identify which 
employee you are assigning contact information for.  
 
The Personal Contacts main screen has the following options: 
¾ New – Allows you to enter a new contact. 
¾ Edit/View – Allows you to change an existing contact. 
¾ Print – Prints the Employee Detail Report. 
¾ Help – Brings up the help file associated with this screen. 
 

Personal Contacts – Details   
Clicking on New or Edit allows you to enter dependent and contact information. All 
dependents need to be entered through this screen before assigning them to a benefit 
plan.   
 

 
 
The first Relation on the Contact Detail Feature is the Employee you want to add 
dependents or contact information to. The title Employee under the Relation drop-down 
box for this person cannot be changed.  
To add a dependent or other contact, follow these steps: 
1. Select an employee from the employee list. 
2. Click New. 
3. Enter First Name, Last Name and Relation information (required fields). Enter other 

fields as needed (Salutation, Maiden Name, Birth Date, SSN, Student, Disabled and 
Dependent info). 

4. Click Save. 
5. Click the Edit Picture to assign a photo to this contact person.  
6. Click Address to add an address to this contact person.  
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Adding an Employee Picture 
A photo gives you a visual image of an employee, their dependent(s) or emergency 
contact person(s). Photos are not required. We recommend you use a digital camera to 
take your photos and save the images in the industry standard JPEG (.JPG) picture 
format or Bitmap (.BMP) format. An image size of 200x200 pixels works best. If your 
picture is larger than this, the program will squeeze your larger picture into the displayed 
picture frame. If your digital camera has TWAIN support, you can import the picture 
right into Optima using the Twain Import feature. 
 
To add an employee picture follow these steps: 
1. From either the Personal Contacts or Employee Detail Feature select the employee 

you want to add a picture to. 
2. Click Edit Picture. 
3. Click Assign New Photo. 
4. Navigate to where the employee picture is. Select it and click Open. If your photo is 

larger than the recommended size (200x200 pixels), you may get a message that asks 
if you still want to assign the file. If you click Yes, the program will try to squeeze 
your larger picture into the frame, however, the larger size of the file will be 
maintained and may make the database larger. 

5. Click Ok.  
 
Using Twain Import 
The Twain Import button allows you to import pictures directly from your Twain-
compliant digital camera. You’ll need to install the software that came with your digital 
camera. To import a photo from your digital camera, follow these steps: 
1. First, you’ll need to make sure that your digital camera is Twain-compliant and that 

the software that came with your camera is installed on the same computer where 
you will run Optima. 

2. Connect your digital camera to your computer. 
3. Open Optima and navigate to the employee you want to add a picture to.  
4. Click on the Personal Contacts Tab. 
5. Select the Edit Picture button and click on the Twain Import button. 
6. Click the Select Source button and then on your camera name. You may have one or 

two options available.  
a. [Camera Name] – This option allows you to take the picture and import it to 

Optima. Go to Taking a Picture and Importing to Optima below to continue 
instructions. 

b. Photos in [Camera Name] - This option will allow you to download and view 
the pictures on your camera’s disk if you’ve already taken pictures. Go to 
Downloading Pictures from Camera Disk below to continue instructions.  
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Taking a Picture and Importing It into Optima 
Continue following these steps from Step 6a above: 
1. After selecting your camera as the source, click OK  
2. Click the Acquire Picture button and click Take Picture. The picture should show up 

on the Twain Import screen.  
3. Click OK to select the picture. 
Note: The instructions for selecting or downloading a picture may be different depending 
on your camera. 
 
Downloading Pictures from Camera Disk 
Continue following these steps from Step 6b above: 
1. After selecting this option, click OK. 
2. Click the Download button to download the pictures to your computer. 
3. Select the picture you want to import, then click Transfer. 
4. Click Ok to select this picture. 
Note: The instructions for selecting or downloading a picture may be different depending 
on your camera. 
 
Saving a Photo to Disk 
All the pictures in Optima are stored in the Optima database (hrware.gdb). This option 
will allow you to save the picture to a different directory, if needed.  
 
To save an assigned photo to your computer, follow these steps: 
Note: The picture must be assigned to an employee before you can save it to a different 
directory.  
1. Click Personal Contacts, then the Edit Picture button. 
2. Click Save Photo to Disk. 
3. Navigate to where you want to save the photo. 
4. Name the photo. 
5. Click OK. The picture can only be saved as a .bmp file.  
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Reminders 
The Reminders Feature will show you all open (unresolved) reminders and allow you to 
create, delete and resolve reminders. If you have created a reminder it will show up when 
you first open the program, starting on the reminder date. Reminders will continue to 
display until you click Resolve.  
 
Reminders Tool Bar and Pane Layout 
Tool Bar 
First-Prior-Next-Last arrows – navigates through selected reminders 
New – Creates a new reminder 
Edit – Allows you to make changes to a reminder 
Save – Saves reminder 
Cancel – Cancels current changes 
Delete – Deletes selected reminder 
Print – Lets you print the Reminders report for selected employees 
Help – Brings up help for this screen 
 
Pane Layout 
Reminder Date – Date reminder should first display 
Title – Heading of reminder 
Resolved – Checkbox displays checked for resolved or unchecked for open (unresolved) 
Employee Name – Displays name of employee that reminder is associated with 
User – Displays name of user that reminder will display for 
Description – The purpose of the reminder shows here 
 
Filters 
User – Allows you to view reminders associated with specific users (must have access to 
Reminders, Assign Users under User Security) 
Show Resolved – Displays Resolved reminders only 
Show Unresolved – Displays Unresolved (open) reminders only 
 
Creating a New Reminder 
There are two types of reminders in Optima:  
One Time Reminders – These are reminders that are only meant to remind you of a 
one-time event, such as filing an EEO Report.  
 
Recurring Reminders – These remind you of repeating events:  
Anniversaries 
Birthdays 
Performance Reviews 
I-9 Renewals 
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Setting a Reminder 
One Time Reminder 
1. Click on Reminders from the Features Column.  
2. Click New.  
3. Select (check) One Time Reminder.  
4. Enter a Title and Reminder Date 
5. If you want the reminder to be associated with specific employees, select the 

checkbox “Assign to all selected (checked) employees.” This is optional and will 
create a separate reminder that is associated with each employee.  

6. If you selected the checkbox in Step 5, you will need to select (check) any employees 
that this reminder is about in the Employee Select Column. Otherwise, skip to the 
next step.  

7. By default, the User’s name will default to the login that was used to enter the 
program. Change this if you want the reminder to come up for another user, or you 
may select Global which allows the reminder to come up for all users logging in. 
Note: You must have access to Reminders, Assign Users and Reminders, Assign 
Global under User Security to be able to change this option.  

8. Enter a description of the reminder, if needed. 
9. Click Save. 
 
Recurring Reminder 
1. To create a recurring reminder, follow these steps: 
2. Select Reminders from the feature list. 
3. Click New. 
4. Select (check) Recurring Reminder. 
5. Select the type of reminder: Anniversary, Birthday, Performance Review, or I-9 

Renewal. 
6. Select a Through Date (when do you want to stop the reminder from occurring). 
7. Select how many days you want to be reminded before the event. 
8. By default, the User’s name will default to the login that was used to enter the 

program. Change this if you want the reminder to come up for another user, or you 
may select Global, which allows the reminder to come up for all users logging in. 
Note: You must have access to Reminders, Assign Users and Reminders, Assign 
Global under User Security to be able to change this option. 

9. Enter a description of the reminder, if needed. 
10. Click Save. 
 
Deleting Reminders 
Reminders are deleted from the Main Reminders screen by clicking on the Delete icon.  
 
Editing Reminders 
There are two ways to edit reminders:  
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Main Reminders screen 
From the main Reminders screen you can edit the following columns just by clicking in 
the field: Reminder Date, Title, Resolved and Description. 
 
Edit Reminders screen 
Clicking on Edit from the main Reminders screen will bring up the Edit Reminder screen. 
You may also double-click on the title of a reminder. The Edit Reminders screen allows 
you to change the Title, Reminder Date, User and Description.  
 
Note: If you need to change the Employee Name that this reminder is about, you’ll need 
to delete the reminder and then re-add it. 
 
Open Reminders 
Open reminders will appear for the user they are assigned unless the Global option is 
checked. If a reminder is marked with Global, then it will show for all users. You may 
view open reminders by opening the program or selecting Reminders from the feature 
list.  
 
Note: If you have security access to “Reminders, Assign Users” (See Security Options p. 
27), you may view reminders set up by other users. You may also resolve reminders from 
the Open Reminders screen. 
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Chapter 6 

Reports 
 
 
Optima creates several reports that relate to employee recordkeeping. For additional 
reporting capability, please try Optima Attendance, Reports and Time Clock which offers 
you the power to track absenteeism and time-off benefit balances. 
 

Creating and Printing Reports  
There are two ways to preview and print a report.  
1. You may preview and print from the individual feature by clicking on the Printer 

icon associated with that feature or:  
2. You may go to the Reports drop-down menu or feature list for more sorting/filtering 

options. 
 
Printing from the Reports Feature or Menu Bar
1. From the Employee Select column, select which employees you want to report on; 

you may use either the Browse mode or TreeView mode to select employees.  
2. From the feature list, click Reports and then choose a report.   
3. Select sorting/filtering options in the Feature Pane, if needed, and click Preview. 
4. Click the printer icon to print. 
 
Each report has basic and additional options for that specific report. 

 
Print Preview 
The Print Preview screen gives you the following options: 
Zoom Buttons – These allow you to zoom each page: Zoom to fit – fits the page to the 
screen; 100% - zooms the page to 100%; Zoom to Width – zooms the width of the page 
to fit the screen.  
Print Setup/Print – These allow you to enter print setup or print the report.  
 
Save to File/Open File – From here you can save the report as a Quick Reports file. 
You can also open an existing Quick Reports file.  Normally, you would not need to save 
as a Quick Reports file.   
Close – This button closes the preview. 
 

Basic Report Options 
Each report has the same Menu, Grouping and Export options:  
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Report Menu Options 
Preview – Displays the report with options to print and setup printer. 
Print – Sends the report to the selected printer. 
Printer Setup – Allows you to change the printer and printer settings. 
Help – Displays help pertaining to this screen. 
 
Grouping Options 
Location – Groups data by Location.  
Department – Groups data by Department. With Location also selected, the report will 
group by location, then department.  
Show Group Totals – Shows total number of employees after Location and/or 
Departments with a grand total at the end of the report. Location and/or Department 
must be selected for this option to be enabled. With both Location and Department 
unselected, the report will group by Last Name in alphabetically order. 
 
Export Options 
Disable Headers on Export – When saving a report from the preview screen, you are 
given the option to save in different formats, such as .txt, .csv and .xls. With this option 
checked, this saves the file without headers so that the data can be manipulated more 
easily without the headers throwing the rows and columns out of place. 
 
Display Options 
Show Social Security Number on Report – This allows you the option of displaying 
the SSN on reports that include this data field. 
 

Report Options 
The following details options found on each report: 
 
Employee Detail Report 
The Employee Detail Report shows pertinent employee information including accrual 
plan assignments, balances, initial balances and notes from the Employee Detail Feature.  
 
Additional options for this report: 
Print Picture – allows you to toggle on or off the assigned employee picture on this 
report. 
Show Social Security Number on Report – allows you to toggle on or off the SSN on 
this report. 
 
Employee Summary Report 
The Employee Summary Report shows an employee’s date of hire, title, status and work 
status. Use this report when you want an employee listing. 
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Employee Anniversary Report 
The Anniversary Report produces a list of employees whose hire dates fall within a 
specified date range. 
 
Additional options for this report: 
From Date/To Date – Runs the anniversary report according to this date range 
Sort By - sorts by specified order 
 
Benefits Report 
The Benefits Report produces a listing of each employee’s benefit status. 
 
Additional options for this report: 
You can show all plans or select one plan to report on. 
Show All Plans - If selected, will report on all plans. 
Plan Name - If Show All Plans is not selected, then you can report on a specific plan. 
 
COBRA Billing Report 
The COBRA Billing Report produces a report on billing records. 
 
Additional options for this report: 
Date Range for Billing Report - If selected, this will report billing records for the 
selected date ranges, otherwise, all billing records will be reported on.  
 
COBRA Status Report  
The COBRA Status Report produces a listing of important COBRA dates (Start, 
Expiration and End Date) for all employees and their dependents, if applicable.  
 
Additional options for this report: 
Date Range for Status Report - Allows you to specify a date range for the report. 
Show Participants - If selected, will display all participants on the report, otherwise, 
participant names will not be shown.  
 
COBRA Delinquent Payments Report 
 
Additional options for this report: 
Date Range for Delinquent Payment Report - Allows you to specify a date range to 
report on.  
 
Dependent Ineligibility Report 
The Dependent Ineligibility Report displays all ineligible dependents up to the date 
specified.  
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Additional options for this report: 
Ineligibility Date - Allows you to enter a specific date to run the report up to. 
 
Dependents Report  
The Employee Dependents Report produces a report of employee dependents. 
 
Additional options for this report: 
Show Social Security Number on Report – toggles on or off the SSN on the report. 
 
New Hires Report  
The New Hire Report produces a list of selected employees hire date and title. 
 
Notifications Report 
The Notifications Report produces a listing of the notices by creation date or printed 
date. 
 
Additional options for this report: 
Notice Created Date - Date when selected notice(s) was initially printed. 
Printed Date - Date when notice was last printed.  
 
Options to report on each of the following notices: Newly Enrolled, 
Qualification/Election, COBRA Unavailability, Billing, HIPAA, Conversion, Insufficient 
Payment, COBRA Termination and Rate Change. 
 
Reminders Report 
The Reminders Report produces a listing of all open reminders sorted by reminder date. 
 
Additional options for this report: 
Sort Options – Sorts by Date, Name, Topic or User Name 
Reminder Date – Selects the date range of reminders to display 
Additional Filters 
User – Shows reminders assigned to selected user 
Display All Users – Shows reminders for all users 
Show Resolved – Shows resolved reminders 
Show Unresolved – Shows unresolved reminders 
Show Global Only – Shows reminders assigned as Global 
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Chapter 7 

Backup and Restore 
 
 
A Backup is essentially a “copy” of your employee records. Backing up ensures that you 
can recover from a computer failure or emergency. You may also install Optima 
applications on another computer (even as a demo) and restore from your backup. For 
example, this is how you would transfer information from an old computer to a new 
computer. 

 
Backup after you make changes to your employee records. 
It is recommended that you backup your database after making any significant changes to 
the records. For example, any time you enter several employees, or input many changes to 
absence information would be a good indication of when to backup. You may also set up 
the DB Monitor to backup at assigned times. 
 
Rotate backups and store backup copies offsite. 
A good backup routine is to have at least three sets of backups covering different days of 
the week.  This practice is called rotation and reduces your risk of data loss. It is also a 
good practice to always keep one copy offsite in case of a fire or flood. Consult your 
system administrator for your company policy regarding data storage. 

 
A Restore is when you recover from a backup. There are three different uses for the 
restore feature. 
1. To overwrite the current data with archived data 
2. To recover from a hardware crash 
3. To move information onto a new computer 

 
Please keep in mind that when you restore data, your information will only be as current 
as the backup you are restoring from.  
 
A  Restore may only be done through the DB Monitor.  

 
IMPORTANT NOTE 

The backup file may only be saved to the Server or Standalone Computer where the 
database resides. The backup creates a zipped up file with an extension of .gbk. 
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Scheduling Automatic Backups 
To create a scheduled backup, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, G.Neil Optima, and 

clicking on DB Monitor. 
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your Administrator. 
3. Click the Backup tab. 
4. Click New Backup. 
5. Enter the Backup Type by selecting Daily, Weekly or Monthly. 
6. Enter the military time in which you would like the backup to take place.  
7. It is recommended to keep the other default settings of Performing Sweep and the 

path of the backup. A different backup will be created for each scheduled backup. 
Note: The name of the backup will be: [Type]_Backup_[mm-dd-yyyy]_[time] to 
distinguish it from other backups. For example, Weekly_Backup_08-02-2001_2300, 
or Monthly_Backup_09_01_2001_1700. 

8. Click Save. The backup will be performed within a minute of the scheduled time. 
Note: The Server or Standalone Computer where the database is located must be 
turned on for the backup to complete. If the computer is not on at the scheduled 
time, the DB monitor will try to create the backup the next time it is opened.  

 

Creating a manual backup  
To create a manual backup, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, G.Neil Optima, and 

clicking on DB Monitor. 
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your Administrator. 
3. Click the Backup tab. 
4. Click Yes to the message, “Do you want to perform a sweep after the backup 

completes?” Note: A Sweep is a maintenance feature that keeps the database 
working at peak performance. 

5. Click OK at the Select Directory screen. It is highly recommended that you keep the 
default location. Note: You may only backup to the Server or Standalone Computer 
where the database resides. 

6. Click Close when the backup is complete. 
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Restoring from a Backup 
Remember, restoring a backup will overwrite all data in the current database. Restore 
may only be run from the DB Monitor on the Server or Standalone computer. To 
restore, follow these steps: 
1. Go to the Server where the database files are located. (Restore cannot be done from 

a Workstation) 
2. Open the DB Monitor program by going to Start, Programs, G.Neil, and clicking 

on DB Monitor. 
3. Enter your login and password. If you do not have access to the DB Monitor Restore 

feature, you will need to see your Administrator. 
4. Click the Restore tab. 
5. Click the database to restore. 
6. Click Browse and double-click the backup you wish to restore. 
7. Click Start Restore. 
8. After Restore is complete, click Hide to minimize the DB Monitor.  
You may open the program to see your restored data. 
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Chapter 8 

Help 
 
 

Sample Company - Tutorial Data 
A sample company (called tutorial database) is provided so that you may view the 
different screens with sample data already filled in.  It is recommended that you use the 
program with the sample database in order to get a feel for the program without having to 
worry about altering live data.  When you are in the Tutorial Data, no changes are made 
to your live database. To open the tutorial database select Start, Programs, G.Neil, 
Sample Database. 
 

The Help Menu 
Select Help and Contents from the main menu. A listing of help topics is displayed. 
Select the Book that interests you (using a double-click) and then double-click the topic 
you wish to display. 
 

The F1 Key 
Pressing the F1 key is another way to obtain online help. From most areas of the 
program, pressing F1 will display the topic associated for that screen. 
 

Searching for Help 
You can search for Help in two different ways using the Help File. 
Method 1 - Select Help and Search for Help on from the main menu. The Help Topics 
Index will appear. Select the Topic that interests you. 
 
Method 2 - Select Help and Contents from the main menu. Click the Find tab. If you 
have not used this feature before, the Find Setup Wizard will walk you through setting up 
the search index. Once the search index has been created, type in the Keywords you 
would like to search for and the results will be displayed. 
 

Typical Issues 
A list of typical errors or messages that were known at the time of publication are listed in  
Appendix B - Troubleshooting. 
For more complete information, please refer to one of the following: 
¾ Readme.txt file located in the Program Files\G.Neil Software\COBRA program 

directory. 
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¾ Help File located within the program by pressing the F1 key or going to Help > 
Contents.  

¾ Internet  site:  www.gneiltechsupport.com 
 

Contacting Technical Support 
Technical Support for Records is available as follows: 
¾ Internet: www.gneiltechsupport.com 
¾ E Mail Requests   techsupport@gneil.com 
¾ Phone Requests   (888) 925-7740  (8:30 a.m. to 6:00 p.m., EST, Monday - Friday) 
¾ Fax Requests   (954) 851-1214 
 
Please be sure to consult the user manual and troubleshooting options before submitting 
a help request. 
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Chapter 9 

Custom Reports   
 
 
Optima applications include an enhanced custom-reporting tool. This tool allows you to 
customize all the reports that are currently included with Optima applications and lets you 
create your own reports from scratch. Note: See Appendix C for a tutorial that will walk 
you through editing and creating reports. 
 
You may access Custom Reports by following these steps: 

 
1. Click the report you would like to customize. For example, from the  Reports menu, 

select Employee Summary. 
2. From the report interface window select Custom Reports. This will bring up the 

custom report interface.  
 
Custom Report Interface 
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Above is the custom report interface in Report Runner. Each portion of this screen is 
described below. 
 
Report Name 
Shows the name of the template. The type of report that is currently in effect is 
“Employee Summary”. All custom reports created and/or modified will have access to 
data specifically designed for the selected report.  
 
Master Filter 
This shows the filter settings carried over from the main report screen. All filters 
EXCEPT the Show Social Security Number on Report and Disable Headers on 
Export will come over.  
 
Action Buttons
The following action buttons are available: 
New – This creates a new report, the “create new report” wizard will start. 
Edit – The selected report will be loaded into the report designer screen. 
Preview – This allows you to view the report before printing. 
Print – This allows you to print the selected report. 
Printer Setup – This allows you to change your printer settings. 
Help – This displays the help for this screen. 
Close – This exits Custom Reports and returns to Attendance Controller. 
 
Other Buttons 
Delete – This deletes custom reports that have been created. You may not delete the 
template.  
Rename – This allows you to rename custom reports that have been created. You may 
not rename the template. 
Make this report available to everyone – If this box is checked this will allow the 
report to be available to other users logging into the program. Otherwise, only the person 
creating the report will see it.  
View Data – This will show the data that you have selected according to the filter and 
sort settings.  
 

Sort and Filters 
 - New      - Edit      - Delete 

 
Custom Sort Fields 
This feature allows you to sort by one or more fields. The sort drop-down box allows you 
to select saved sort settings.  
New – This allows you to save a specific sort order. 
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Edit – This allows you to edit the selected sort order. 
Delete – This deletes the selected sort order 
 
To create a new custom sort, follow these steps: 
1. Select a report from the Reports menu. 
2. Click Custom Reports.  
3. Select the appropriate report or click New to create your own. 
4. Click the NEW button next to Custom Sort. 
5. Enter a name that will designate what type of sort this will be, such as Last Name or 

SSN. Click OK. 
6. Select which field(s) you want to sort on by either double clicking on the field or 

clicking once on it and clicking the right arrow button. The sort order will be 
designated by which field is at the top. For example, if you have selected to sort on 
the Last Name and EESSN fields, with the Last Name field at the top, it will sort 
first by Last Name and then by SSN on the report. You may change the order of the 
fields by clicking on the UP and DOWN buttons. 

7. Click MAKE DEFAULT. This keeps the sort settings assigned to the selected 
report. 

8. Click OK. 
9. See below for setting up custom filters. 
10. Click EDIT or PREVIEW.  
See Appendix C for a tutorial that will walk you through editing and creating reports. 

 
Custom Filters 
This feature allows you to filter on one or more fields. The filter drop-down box allows 
you to select saved filter settings. 
New – This allows you to save a specific filter setting. 
Edit – This allows you to edit the selected sort order. 
Delete – This deletes the selected sort order. 
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Field – This allows you to select the field to filter on. Note: These are the only fields 
allowed. 
Operator –  
a. =  - equal to 
b. >  - greater than 
c. >=  - greater than or equal to  
d. <  - less than 
e. <=  - less than or equal to 
f. <>  - not equal to 
Value – This allows you to enter a value to filter on. 
AND – This enters the statement. Click ‘AND’ after each statement you create.  
OR – This allows you to set an OR statement (this OR that). 
(  ) – This allows statements that need to be done first such as in Math calculations (a+b)-
c. 
Edit – This allows you to edit a line. 
Del – This allows you to delete a line.  
Test – This will check for correct syntax.  
Make Default – This makes this filter the default filter for the selected report.  
 
To create a new custom filter, follow these steps: 
1. Select a report from the main menu. 
2. Click Custom Reports. 
3. Select the appropriate report or click New to create your own. 
4. Click the NEW button next to Custom Filter. 
5. Enter a name that will designate what type of filter this will be, such as SSN. Click 

OK. 
6. Click the drop down arrow for Field and select a field to filter on. 
7. Click the drop down arrow for Operator and select the type of filter. 
8. Click the drop down arrow for Value and enter a value. 
 For Example, Select LastName for the Field, select “=” for the Operator,  and enter 

“A*” for the Value. After clicking Make Default and OK, when  the report is 
previewed it should show all names that start with the letter  “A”. 

9. Click “AND” to set the query. This will bring it into the window. 
10. Set any other queries as needed. 
11. Click Make Default. 
12. Click OK.  
13. Click Preview to show your settings. 
 
TIP: If you several lines in a query and you delete the first one, make sure the top one 
doesn’t begin with AND.  
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Master Filter 
This shows the filter settings carried over from the main report screen. All filters 
EXCEPT the Show Social Security Number on Report and Disable Headers on 
Export will come over.  
 
Action Buttons
The following action buttons are available: 
New – This creates a new report, the “create new report” wizard will start. 
Edit – The selected report will be loaded into the report designer screen. 
Preview – This allows you to view the report before printing. 
Print – This allows you to print the selected report. 
Printer Setup – This allows you to change your printer settings. 
Help – This displays the help for this screen. 
Close – This exits Custom Reports and returns to Attendance Controller. 
 
Other Buttons 
Delete – This deletes custom reports that have been created. You may not delete the 
template.  
Rename – This allows you to rename custom reports that have been created. You may 
not rename the template. 
Make this report available to everyone – If this box is checked this will allow the 
report to be available to other users logging into the program. Otherwise, only the person 
creating the report will see it.  
View Data – This will show the data that you have selected according to the filter and 
sort settings.  
 
Additional Information 
A report template is provided for each of the standard reports in Optima applications. If 
you view these templates by clicking on the Preview button from the Custom Reports 
Main Screen you will notice that the templates look the same as the standard report. 
These templates are provided to make it easier for you to make modifications to the 
standard report. For example, if you want to remove fields from a standard report simply 
delete the field from the template, save it, and you have your own custom report. Please 
note that the program does not allow you to modify a template and requires you to give 
your customized report a new name. For a detailed walk through of how to customize a 
template, see the included step-by-step guide in Appendix C. (Custom Report Tutorial # 
1).  
 
Creating a New Report 
You can create your own customized report from the data provided for each report type 
by clicking on the New button from the Custom Reports main window. When the design 
screen appears, you are presented with the Report Wizard. The report wizard walks you 
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through the process of creating a basic report. If you wish to learn how to create your 
own report, a step-by-step guide to creating a report from scratch is provided in 
Appendix C (Custom Report Tutorial # 2). 
 

Edit/Design Screen  
 

 
 
The above picture shows Custom Report’s main design screen.  This is the screen where 
you will be modifying or creating custom reports. The toolbars are described in detail 
below: 
Toolbars 
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You can change many report element properties directly with the toolbar instead of using 
the element’s property dialog. Additionally, you can use it to modify multiple elements at 
once. 
 

 These buttons are for creating a new report and saving a report. 
 

 Use these buttons to print the report or to view a preview of the printout. 
 

 With these buttons, report elements can be cut to, copied to or pasted 
from the report designer’s clipboard. 

 

 These buttons are used to set a report element to the background or bring it in 
front of all other report elements, in case of overlapping elements. 
 

 Report elements can be arranged 
with these buttons. Some of the buttons are only enabled when multiple elements are 
selected (for example to align the left edges). 
 

 Here you can set font and font styles 
of the selected report elements (font name, font size, bold, underline, italic). 
 

 These buttons are for aligning text within a report element. Text can be 
aligned left, right or centered. Of course this only makes sense if the report element’s size 
is bigger than its text, and if “autosize” is deactivated. 
 

 With this button, you can open a dialog to set the frame options for the selected 
element. 
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These button run down the left side of the design screen. 

 
 
Report Elements 
Each button is used for adding report elements to the report. To add an element to the 
report, you must click its button and then click on the report where you want the element 
to be inserted. Of course you can still move a report element to another position later.  
 
Standard Report Bands 
All standard report bands are added with the same button (see above). The band type is 
selected with the band’s property dialog. 
 
The following band types are available: 
¾ Title: The title band will be printed on the first page of the report as a report title. 
¾ Page header: The page header is printed at the top of each report page. 
¾ Column header: The column header is used with reports that have multiple 

columns (can be set with “Report|Options”). 
¾ Detail: The detail band is the most important report band. It is printed once for each 

data record from the main report table. 
¾ Group footer: The group footer is printed at the end of a group, before a new group 

starts. You can find more information on groups at the chapter describing the group 
band. 

¾ Summary: The summary band is printed at the end of the report, after all data 
records have been printed. 

¾ Page footer: The page footer is printed at the bottom of each report page. 
 

Report Band 
The band properties for these bands are all set with the same property dialog. The 
following options are available: 
 
Type: Band type (see above) 
 
Color:  
This defines the background color of the report band. 

 
Print: 
¾ not on first page: prints the band only on the second page and following 
¾ not on last page: suppresses printing of the band on the last report page 
¾ even page numbers only: only prints the band on even page numbers 
¾ odd page numbers only: only prints the band on odd page numbers 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
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¾ force new page: starts a new page before printing the band 
¾ force new column: starts a new column before printing when using reports with 

multiple columns 
Only print band if expression is true: 
An expression can be used to determine whether the band should be printed or not. The 
expression must have a logical result of “true” or “false”. Press the button on the right 
side of the expression edit line to use the expression expert. 
 
Frame: 
A frame or single frame lines can be drawn around the report band. You can select which 
lines should be drawn, in which color, style and width. 

 
Child Band 
A child band is a band which is attached to another report band and which will always be 
printed below its parent band. This way you can print an additional band after each detail 
band for example. The advantage of using child bands instead of just resizing the parent 
band to make room for more report elements is that there can be a page break between a 
band and its child, if needed, and the child band can be printed independently from its 
parent band, even if the parent band is not printed.  
 
You must use child bands if you have report elements with “Autostretch” set to true and 
you want to print element below such auto-resizing fields. In this case place all the 
elements which should be moved down automatically because of autostretching elements 
before them on a child band. 
 
The following options are available: 
Parent Band: The band to which the child band is attached. 
 
Color:  
This defines the background color of the report band. 

 
Print: 
¾ not on first page: prints the band only on the second page and following 
¾ even page numbers only: only prints the band on even page numbers 
¾ odd page numbers only: only prints the band on odd page numbers 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
¾ force new page: starts a new page before printing the band 
¾ force new column: starts a new column before printing when using reports with 

multiple columns 
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Only print band if expression is true: 
An expression can be used to determine whether the band should be printed or not. The 
expression must have a result of “true” or “false”. Press the button on the right side of 
the expression edit line to use the expression expert. 

 
Subdetail Band 
A subdetail band is a sort of detail band, but it is subordinate to the real detail band. For 
example, if you want to print a list of audio CDs, and for each CD a title list should be 
printed, you would use a detail band for printing the CD names and connect a subdetail 
band to the titles dataset, so separate lists of titles are printed below each CD name.  
 
The following options are available for the subdetail band: 
 
Table:  
This is the dataset that is used by the subdetail band. 
 
Color:  
This defines the background color of the report band. 
 
Master:  
The master is the table superior to the subdetail table. For each record in the master table 
a subdetail list is printed. 
 
Only print if expression is true: see  Standard bands. 
 
Print 
¾ before master-detailband: prints the subdetail records before printing their master 

record from the detail band 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
¾ print header/footer even if dataset is empty: header and footer bands of the 

subdetail band will be printed even if there are no subdetail data records to print 
¾ force new page: starts a new page before printing the band 
¾ force new column: starts a new column before printing the band (when using 

reports with multiple columns) 
 

Headerband:  
This band is printed as a header before the subdetail data records are printed. 
Footerband:  
This band is printed as a footer after the subdetail data records have been printed. 
 
Frame: see Standard bands. 
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Group Band  
A group band is used to structure data into groups of data records. For example, if you 
want to print a list of addresses, you can add some space before each new first letter starts 
and insert some caption, or you can group addresses by city or state. 
 
Example 

 
Internally, groups are handled the following way: Before printing a data record, the report 
engine checks if the expression result of the group band is different from the last data 
record’s expression result. If this is the case, the group band will be printed, or else it 
won’t. This way data can be grouped with great flexibility, because you can use the 
expression for nearly any kind of calculation. 
 
The following options are available: 
 
Master:  
Defines which is the master band for the group. This can be either the detail band or a 
subdetail band. The group is checked each time the master band is printed. 
 
Color:  
This defines the background color of the report band. 
 
Expression: 
This expression determines whether a group band is printed or not. The band will be 
printed each time the result of the expression changes. 
 
Print 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
¾ force new page: starts a new page before printing the band 
¾ force new column: starts a new column before printing when using reports with 

multiple columns 
 
Footerband:  
This band is printed at the end of each group, before the next group band is printed. 
 
Frame: see Standard bands. 

 
The following picture shows a report with a group band (the bold printed single character 
is located on the group band) and a report without a group band on the right side.  
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Label 
A label is for printing static text, i.e., text that is printed exactly like it is displayed during 
report design. 
 
The following options are available: 
 
Text: 
This is the text that should be printed. You can only type in one line of text. Memos can 
be used for multi-line text. 
Rotation: 
Use this to rotate your text. Rotation can be set to anything between 0 and 360 degrees. 
90 degree means displaying the text vertically, for example. 
Font: 
Selects the font for the report element. 
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 
 
Alignment: 
The report element’s text can be aligned left, right or centered. 
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Automatic word-wrap: 
Set this option if you want the text to wrap to the next line if it does not fit into the given 
width (similar to a word processor software).  
 
Transparent: 
The report element’s background will not be printed if this option is activated. This way 
you can place text on top of an image, for example, without hiding the image under a 
white box with text. 
 
Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size, text will be clipped off. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
 
Memo 
A memo is used to print text that has more than one line. Just like a label a memo displays 
text in one color and font. If you want to use formatted text, you can use a Richtext field. 
 
The following options are available: 
 
Text: 
This is the text that will be printed. 
 
Font: 
Selects the font for the report element. 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 
 
Alignment: 
The report element's text can be aligned left, right or centered. 
 
Automatic word-wrap: 
Set this option if you want the text to wrap to the next line if it does not fit into the given 
width (similar to a word processor software).  
Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size, text will be clipped off. 
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Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
Image 
An image element is a bitmap from a BMP file that is inserted into the report. 
 
While a datafield is for displaying text from a database record, you can use this report 
element to display images that are stored in a database. 
 
The following options are available: 
 
Datafield: 
The field that contains the image (if there is no bitmap in this field, nothing will be 
printed). If the datafield property is set to a database field which is not of type "bitmap", 
the report engine will try to find a bitmap file whose name equals that of the data field's 
content and load it. 
 
Stretch picture automatically: 
Activate this option to stretch the picture so it fits exactly into the report element’s size, 
or else the picture will be cut off if there is not enough room, or space will be left empty if 
there is too much. 
 
Center picture: 
If the report element is bigger than the picture and the “Stretch” option is not activated, 
the picture will be centered in the report element instead of being placed in the top left 
corner. 
 
Alignment: 
Aligns the image on the report band. 
 
Shape 
This report element can be used to draw (horizontal or vertical) lines, circles and 
rectangles.  
 
The following options are available: 
 
Type: 
Selects the shape, which can be a circle, rectangle, horizontal line, vertical line or 
top/bottom and left/right lines. 
 
Brush: 
¾ Style: different styles to fill a circle or rectangle 
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¾ Color: the color that is used to fill the shape 
 

Pen: 
¾ Width: line width of the shape 
¾ Mode: various line drawing modes 
¾ Style: solid, dotted or dashed lines 

 
System Field 
This report element is used to display various system data like current time or date, page 
number, etc. 
 
Available options: 
 
Text: 
This text will be displayed before the actual system data. For example you can use the text 
“Report printed on:” when printing the current date. 
 
Type: 
The type of system data to print. The following types are available: 
¾ Date: the current date when printing the report 
¾ Time: the current time when printing the report 
¾ Date/Time: the current date and time 
¾ Detail count: total number of data records 
¾ Detail number: number of the current data record 
¾ Page number: current page number of the printout 
¾ Report title: the report title which can be set via “Report|Options” 
 
Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size, it will be clipped off. 
 
Transparent: 
The report element’s background will not be printed if this option is activated. This way 
you can place text on top of an image for example, without hiding the image under a 
white box with text. 
 
Font: 
Selects the font for the report element 
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 

81 



 

Data Field 
A datafield displays data from the report table. This can be numerical data, characters or 
multiple lines of text. 
 
The following options are available: 
 
Data field: 
Select the data field you want to print. 
 
Alignment: 
The report element's text can be aligned left, right or centered. 
 
Format: 
Numerical data fields can be formatted by setting a format definition. 

 
Font: 
Selects the font for the report element 
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 
Automatic word-wrap: 
Set this option if you want the text to wrap to the next line if it does not fit into the given 
width (similar to a word processor software).  
 
Transparent: 
The report element’s background will not be printed if this option is activated. This way 
you can place text on top of an image for example, without hiding the image under a 
white box with text. 
 
Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size then text will be clipped off. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
 
Suppress printing of repeated values 
Activate this option if you do not want  to print data fields with the same values 
repeatedly. The report engine will only print the data field for the first data record, and 
leave all following prints of this data field empty if the field’s content hasn't changed. 
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Suppress printing if value of datafield is 0 
This option suppresses printing of numerical fields if their value equals zero. 
 
Reprint on new page 
If you have activated “Suppress printing of repeated values”, you can use this option to 
reprint a field if a new page starts, even if it would be suppressed normally because of 
equal values. 
 
Reprint on new group 
Same as “Reprint on new page” but for groups. 
 
Image from Data Field 
While a datafield is for displaying text from a database record, you can use this report 
element to display images that are stored in a database. 
 
The following options are available: 
 
Datafield: 
The field that contains the image (if there is no bitmap in this field, nothing will be 
printed). If the datafield property is set to a database field which is not of type “bitmap”, 
the report engine will try to find a bitmap file whose name equals that of the data field’s 
content and load it. 
 
Stretch picture automatically: 
Activate this option to stretch the picture so it fits exactly into the report element's size, 
else the picture will be cut off if there is not enough room, or space will be left empty if 
there is too much. 
 
Center picture: 
If the report element is bigger than the picture and the “Stretch” option is not activated, 
the picture will be centered in the report element instead of being placed in the top left 
corner. 
 
Alignment: 
Aligns the image on the report band. 
 
Expression Field 
A calculated field (expression field) is used for displaying text or data that is calculated by 
an expression or formula. You can do numerical calculations, string manipulations, 
concatenate data fields and much more. 
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Expression: 
This expression is evaluated each time the calculated field is going to be printed (see the 
chapter on expression syntax). 
 
Format: 
Numerical fields can be formatted by setting a format definition. 
 
Font: 
Selects the font for the report element. 
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 
 
Master: 
If your expression uses any aggregated functions, you must link the “Master” property 
to the dataset that will be used to update the expression. Each time a new data record 
from this dataset is selected, the expression will be recalculated. 
 
Alignment: 
The report element’s text can be aligned left, right or centered. 
 
Rotation: 
Use this to rotate your text. Rotation can be set to anything between 0 and 360 degrees. 
90 degree means displaying the text vertically, for example. 
 
Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size, text will be clipped off. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
 
Reset after print: 
If you are using calculations like sums or counting of data record etc., you can use this 
option to reset the value of the calculation to zero after the report element has been 
printed. 
 
Automatic word-wrap: 
Set this option if you want the text to wrap to the next line if it does not fit into the given 
width (similar to a word processor software).  
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Transparent: 
The report element's background will not be printed if this option is activated. This way 
you can place text on top of an image for example, without hiding the image under a 
white box with text. 
 
Richtext Field 
The richtext element is a report element that can display multi-line text with different 
fonts, colors and formatting. In the richtext property dialog, press the "Edit" button to 
show a text editor with richtext editing capabilities. 
 
Alignment: 
sets the text alignment if no alignment has been set with the editor. 
 
Font: 
sets the font if no font has been specified with the editor. 
Color: 
sets the text color if no color has been set with the editor. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
 
Richtext from Data Field 
This report element displays richtext from a data field. The following options are 
available: 
 
Data field: 
Select the data field to use by the report element. 
 
Alignment: 
sets the text alignment if no alignment has been set with the editor. 
 
Font: 
sets the font if no font has been specified with the editor. 
 
Color: 
sets the text color if no color has been set with the editor. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of the 
elements will be stretched to make room for all lines. If needed, the report band will be 
stretched too. 
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Keyboard and Mouse Shortcuts 
The report designer can be used with the mouse most of the time. Some functions can 
also be accessed with the keyboard: 
 
Enter: 
Show the element’s property form. 
 
Cursor keys: 
Move a report element. 
 
Shift + Cursor keys: 
Resize a report element. 
 
Del: 
Delete a report element. 
 
Tab and Shift + Tab: 
Select next or previous report element. 
 

Using the mouse 
Select a report element 
Report elements are selected by clicking them with the left mouse button. A selection is 
shown with eight small black boxes around the element: 

 
Change the size of an element 
You can use the small boxes of a selected element to change its size. If the mouse cursor 
is positioned over such a box, the cursor will change to show in which direction the 
mouse can be moved while the left mouse button is pressed down. The element will be 
resized accordingly. Please note that for report bands only the height can  be changed, but 
the width is set to the report width automatically. 
 
Select multiple elements (a) 
You can select multiple elements by holding down the [Shift] key while selecting them 
with the left mouse button. This way the previous selection will remain when a new 
element is selected. 
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Select multiple elements (b) 
You can also select multiple elements by using a so-called "rubber band". Hold down 
[Ctrl] together with the left mouse button and drag a frame around the elements that you 
want to select. After releasing the mouse button, all elements within the frame are 
selected. 
 
Move elements: 
You can move report elements with the left mouse button. Hold down the button, drag 
the element to the desired location and release the mouse button. Report bands cannot be 
moved because they are positioned automatically according to their band type. 
 
Move and resize elements regardless of the current grid setting: 
If you want to manipulate a report element regardless of the current grid (menu item 
“View|Options”) and move or resize by one pixel, then hold down the [Shift] key while 
moving the mouse. 
 
Edit element properties 
If you double-click a report element with the left mouse button, or if you select “Edit” 
from the element’s popup menu (which can be accessed with the right button), a dialog 
will be shown where all element properties can be edited. 
 
Script Language Guide 
Custom Reports comes with an integrated script language for creating “BeforePrint” and 
“AfterPrint” event handlers at runtime. You can use it to design reports with various 
special features and advanced calculations. 
As a simple example, let’s say that you have a report printing a list of numbers, some of 
which may be positive and some may be negative. Suppose you would like the positive 
numbers to appear in Black and the negative numbers to appear in Red. For this you can 
write a script for the detail band’s “BeforePrint” event from within the report editor 
(right-click on the band after you have selected it and choose “Scripts” from the popup 
menu): 
You would enter the following in the “BeforePrint” window: 

 
if (Amount>=0) 
  SetFontColor(‘AmountDBText’,Black) 
Else 
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  SetFontColor(‘AmountDBText’,Red) 
Endif 

 
The above script will be executed before each line is printed. ‘AmountDBText’ is the 
name of the text component which is linked to the Amount field in the dataset. It is 
important to note that each component on the report must be given a name if you wish 
to access it through a script. To give a component a name, right-click on the component 
after you have selected it and choose “options”. The first field displayed is Name. This is 
where you would enter a name for the component. The name that is entered here is what 
you must use to access the component in script code. 
 

Using Variable in Script Language 
Variables are declared, set and get with functions. Variables are global, i.e., you can set a 
variable in one event handler script and use it in another. You can even set a variable in 
one report and use it in a second report executed afterwards. Variables are not initialized 
to some value when a report is generated.  

 
SETVAR 
 
To set a variable, use the SETVAR function with variable name and variable value as 
parameter. SETVAR automatically creates a new variable if it doesn't exist, or else it will 
overwrite the value of the given variable. 
SETVAR(‘Temp’,’This is a test string’) 
 
SETVAR('Num',1000) 
 
SETVAR('Flag1',TRUE) 

 
GETVAR 
To get a variable value, use the GETVAR function with the variable name as parameter. 
The result type of GETVAR depends on what kind of variable (string, number, boolean) 
has been created/set with SETVAR. 
GETVAR('Temp') 
 
IF (GETVAR('NUM')>0) 
  RETURN(FALSE) 
  EXIT 
ENDIF 

 
SETVAR('Num',GETVAR('Num')+1) 
 
SetStringProp('QRLabel1',GETVAR('Temp')+' !!!') 
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VAREXISTS 
To check if a variable exists (i.e. has been created with a first call of SETVAR), use the 
VAREXIST function with the variable name as parameter.  
 
IF (VAREXISTS('Flag1')) 
: 
: 
ENDIF 
 
DELETEVAR 
 
To delete a variable from memory, use the DELETEVAR function with the variable 
name as parameter. VAREXISTS will return FALSE for this variable afterwards. 
 
DELETEVAR('Temp1') 
 

Script Language Syntax Guide 
IF...ELSE...ENDIF: 

 
IF (Condition) 
: 
ENDIF 
 
IF (Condition) 
: 
ELSE 
: 
ENDIF 

 
Note that between the "IF" and "(Condition)" there MUST be a blank. Do not place 
commands on the same line as the IF statement, but only on new lines. 
 
"Condition" can be any script code expression returning TRUE or FALSE, e.g., "IF 
(Weight>10)" 
 
The lines below the IF statement until ENDIF or ELSE are the commands to be 
executed if "Condition" evaluates to TRUE. 
 
Examples:  

 
IF (Amount*1.16>800) 
  OKBox('Warning: Amount including VAT is larger than 800') 
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ENDIF 
 
IF (YesNoBox('Print report now?')) 
  RETURN(TRUE) 
ELSE 
  RETURN(FALSE) 
ENDIF 

 
LOOP...ENDLOOP 

 
LOOP 
: 
ENDLOOP 
 
You can place expression commands between LOOP and ENDLOOP, and when 
reaching the ENDLOOP statement the script will start again at the line below LOOP. 
You can exit the loop only by using the BREAK or BREAKLOOP commands (see 
below).  
 
Example: 
 
SetVar('Temp',1); 
LOOP 
  SetVar('Temp',GetVar('Temp')+1); 
  IF (GetVar('Temp')>10) 
    BREAKLOOP 
  ENDIF 
ENDLOOP 
 
BREAK 
BREAK has no parameters, it just exits from the current IF or LOOP block instantly, 
continuing with the commands following the ENDIF or ENDLOOP statement. Note 
that in the above example, break would only exit from the IF statement, not from the 
loop. 

 
BREAKLOOP 
This is the same as BREAK, only that it exits from the current loop no matter if 
BREAKLOOP is used from within one or more IF blocks. 

 
EXIT 
EXIT has no parameters. It just completely exits the script execution instantly. 
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RETURN 
RETURN(Expression) 
 
RETURN sets the current scripts result (a result is needed for the BeforePrint event: 
TRUE to confirm printing of the current band, FALSE to skip printing the band). 
"Expression" must evaluate to TRUE or FALSE. 
 
Example: 

 
RETURN(FALSE) 
RETURN(Weight>10) 
 
The second example would only print the band if the WEIGHT datafield value is greater 
than 10. 

 
 

ElementExists(Name: String): Boolean 
Checks if a report element with the given name exists.  
Example: ElementExists('Label1') 

 
 

SetBoolProp(ComponentName, PropertyName, PropertyValue) 
Sets a boolean property for a component. 

 
Example: SetBoolProp('Childband1','Enabled',False) 
                    SetBoolProp('MyShape','Enabled',True) 

 
SetIntProp(ComponentName, PropertyName, PropertyValue) 
Sets a numeric property for a component. 
Example: SetIntProp('Band1',Height,200) 
SetFloatProp(ComponentName, PropertyName, PropertyValue) 
Sets a floating point property for a component. 

 
SetStrProp(ComponentName, PropertyName, PropertyValue) 
Sets a string property for a component. 
Example: SetStrProp('Label1','Caption','This is a test') 

 
GetBoolProp(ComponentName, PropertyName, PropertyValue): Boolean 
Reads a boolean property from a component. 
Example:  
IF (GetBoolProp('DBText1','Enabled)) 
  SetColor('DBText1',Black) 
ENDIF 
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GetIntProp(ComponentName, PropertyName): Integer 
Reads a numerical property from a component. 

 
Example: SETVAR('LastBandHeight',GetIntProp('DetailBand','Height')) 

 
GetFloatProp(ComponentName, PropertyName): Float 
Reads floating point property from a component 

 
GetStrProp(ComponentName, PropertyName,): String 
Reads a string property from a component 

 
Example: GetStrProp('Expr1','Caption') 

 
OkBox(Text: String) 
Shows a message dialog with the given text and an OK button. 

 
Example: OkBox('Fasten your seat belts') 

 
OkCancelBox(Text: String): Boolean 
Shows a message dialog with the given text and both an OK button and a CANCEL 
button. Returns TRUE if the OK button has been pressed, FALSE otherwise. 

 
Example:  
IF (OkCancelBox('Print now?')) 
  Return(True) 
ELSE 
  Return(False) 
ENDIF 
 
YesNoBox(Text: String): Boolean 
Same as "OkCancelBox" but with "Yes" and "No" buttons. 
InputBox(Title, Text, VariableName): Boolean 
Shows an input dialog. The user must type in a value that is stored in the given variable. 
 
Example: InputBox('Input start date','Start date:','VDate') 

 
SetColor(Name, Color) 
Sets the (background) color of the given report element. The color parameter is a 
numerical value, but the following constants are available: Black, Maroon, Green, Olive, 
Navy, Purple, Teal, Gray, Silver, Red, Lime, Blue, Fuchsia, Aqua, White. You can also use 
the RGBCOLOR function (see below). 
 
Example:     SetColor('Childband2',Yellow) 
                    SetColor('Childband2',87123) 
                    SetColor('Childband2', RGBColor(255,0,128)) 
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RGBColor(Red, Green, Blue): Integer 
This function creates a color value for use with SETCOLOR and SETFONTCOLOR 
from red, green and blue parts. 
 
Example: RGBColor(64,0,0)       (gives a dark red) 

 
SetFont(ComponentName, FontName) 
Sets the font for a given component. 
 
Example: SetFont('Label1','Arial') 

 
SetFontColor(ComponentName, Color) 
Sets the font color for a given component. Please see the description of SETCOLOR 
above. 

 
SetFontSize(ComponentName, Fontsize) 
Sets the font size for a given component 

 
Example: SetFontSize('TitleLabel',24) 

 
SetFontStyle(ComponentName, IsBold, IsItalic, IsUnderline, IsStrikeout) 
Sets the font style (bold, italic, underline and strikeout) for a given component. Each style 
is a boolean (true/false) parameter that must be set to TRUE for activating it. 
 
Example: SetFontStyle(DBText1,true,false,false,false) 
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Script Code Examples 
Displaying column totals 
Probably the most common use for the script code is to total a column. To accomplish 
this is quite easy. Follow these steps to total a column. This example assumes you have at 
least the following bands on your report: title or column header band, detail band, 
summary or group footer band. 
 
Add the following code to the “BeforePrint” event of the title or column header band: 
SETVAR(‘COLUMNTOTAL’, 0) 

 
The above line simply creates a variable named COLUMNTOTAL and sets it to 0. 
Add the following code to the “BeforePrint” event of the detail band: 
SETVAR(‘COLUMNTOTAL’, GETVAR(‘COLUMNTOTAL’) + Table1.COST) 

 
The above line does the following:  Sets the variable COLUMNTOTAL equal to itself 
plus the COST field of Table1 (Table1 is the generic name of all Custom Reports 
datasets). The above line of script code will execute once for every line of data in the 
dataset. Because of this it keeps adding the cost to the running total of the 
COLUMNTOTAL variable. 
 
The next step is simply to display the COLUMNTOTAL variable in the summary or 
group footer band. Add an Expression field component to either the summary or group 
footer band. Add the following code to the Expression field: 

 
GETVAR(‘COLUMNTOTAL’) 

 
The above line simply returns the value stored in COLUMNTOTAL and it is displayed in 
the summary or group footer band. 

 
Displaying Row Totals 
Displaying totals across rows is somewhat easier than column totals and requires script 
code to be added to only one event:  the detail band. Begin by adding the following line of 
code to the “BeforePrint” event of the detail band: 
SETVAR(‘ROWTOTAL’, Table1.VALUE1 + Table1.VALUE2 + Table1.VALUE3) 

 
Substitute VALUE1, VALUE2, VALUE3 with the names of the fields you wish to add. If 
you want to add more or less than 3 fields, simply continue the same pattern as shown 
above.  

 
The above line declares a variable named ROWTOTAL and sets it equal to the sum of 
VALUE1 + VALUE2 + VALUE3. The variable now contains the proper total that needs 
to be displayed. Remember that any code added to the detail band will fire once for every 
record in the dataset. The above line of code will add the three fields for each record. Add 
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an Expression field component to the detail band. Add the following code to the 
Expression field: 

 
GETVAR(‘ROWTOTAL’) 
The above line simply returns the value stored in ROWTOTAL and it is displayed in the 
detail band. 

 
See Appendix C for tutorials on editing a template, and creating a report from 
scratch. 
 

Creating Reports Through Other Software 
You may create reports through other report writer software, such as Crystal Reports 
(sold separately.) In order to do so, you will need to set up a guest user account. A guest 
user account will allow access to specific tables within the database. 
  

 
 

Setting up a Guest User 
To set up a Guest User account, follow these steps: 
 From within the program, click Settings, Guest Users. 
1. Click New. 
2. Enter a Login Name. 
3. Enter the users Full Name. 
4. Enter a Password. Then enter it again to verify the password. 
5. Select the Table Name for the user to have access to and click in the Access block 

where it has “No Access”. For example, to give Read, Write, Delete access to 
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AbsenceClasses, click on “No Access”, then click on the down arrow and select 
Read, Write Delete. 

6. Follow step 5 to set up access to each table with the appropriate access. 
7. Click Save.  
8. Clicking Edit will allow you to make changes to the record. 
 
Once guest user access is set up, the user may connect to the Optima database through 
other report writer programs. The report writer must have an ODBC driver that is 
compatible with Interbase 6 Dialect 3. (We recommend EasySoft’s ODBC-Interbase 6 
Driver, available at www.easysoft.com.) 
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Chapter 10 

Import and Export 
 
 
The import feature allows you to add new data from a text file into the Optima program. 
Conversely the export feature allows you to export data from the Optima program. 
 
The software that you export your data from must be able to export the required 
information to a tab delimited or fixed length text file. See Appendix D for the required 
import fields. Please note that we cannot provide support for other software program(s). 
Please contact the software vendor or manufacturer for more information on how to 
export data from your other software.  
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Features 
Load File – Loads the selected file into the data window. 
Test – This tab will not highlight until a file is loaded. This checks for blank records and 
ensures that the department and location names that are being imported are already in the 
database.  
Import – This tab imports the file into the database.  
Help – This brings up the Help file pertaining to Importing. 
Close – This closes the Import screen and takes you back to the main screen. 
Import File Type – This allows you to select the file type.  
¾ Tab Delimited – We recommend exporting or importing as this type of file.  
¾ Fixed Length – Optima may export or import fields with a fixed length. See 

Appendix D on the field lengths.  
Skip First Line (Headers) – This will take out the first line, in case you have headers. 
Import File – This allows you to enter the path or navigate to the file you will be 
importing.  
Check Duplicates – This allows you to check for duplicates against the import file and 
the files already in the database. 
 

Required Fields 
The following are required fields for importing: 
Last Name 
First Name 
Location – name must be in the Optima database prior to importing 
Department – name must be in the database prior to importing 
Date of Hire 
Full/Part Time 
Active Status (Active, Inactive, or Terminated) 
 

Importing 
To import your information, follow these steps: 
 
From within the program click File, Import. 
1. Enter the path of the file or click on the  to navigate to it.  
2. Select Tab Delimited or Fixed Length. This should correspond with the way the 

import file was saved.  
3. Select Skip First Line if you have title headings. Do not select Yes if you don’t have 

title headings or you may lose the first line of data.  
4. Click Load File to preview the file. At this point you should check that all column 

headings match the fields that will be imported.   
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Note the column titles above: SSN, Lastname, Firstname, and Middlename; check each 
column to make sure the appropriate data is in the correct column. For example, the SSN 
number should have an 11-digit number plus two hyphens. 
1. Select which fields to check for duplicates in the Check Duplicates box. Duplicates 

will be checked during the Test File phase. 
2. Click Test File. This checks for blank required fields, and in the case of Location 

and Department, it checks to make sure that the name of the Location and 
Department has already been set up within the program.  

CAUTION:  If duplicates were detected and you click on Import, these fields will be 
imported into the program.  
3. Once it passes the Test portion, you will be able to click on Import File.  
 

Exporting 
The export feature is used to transfer basic employee information into a text file that you 
can open in any word processor or spreadsheet application. Only the basic information 
(see Field Layout in Appendix D) will be exported.  
 
To export your information, follow these steps: 
1. Click File, Export. 
2. Select Tab Limited or Fixed Length for the Export File Type. 
3. Enter a path and file name or keep the default name. 
4. Click Export.  
 
Your export file will be created as the file designated in the file block. You may rename 
the file, but we recommend keeping the file extension of .txt. After exporting you may 
open the file from within any other spreadsheet or word processor program.  
 
Note: Only the information in the Field Layout will be available for export.  
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Appendix A 

Report Icons 
 
 
You’ll see each of these icons when you click on Preview for a specific report. 

 
 
1. The first 3 icons control how the report page is previewed. The first icon zooms the 

report to fit the whole page. The second icon zooms the report to 100% of its size. 
The third icon zooms the report to the width of the screen. This is the normal view 
when previewing reports. 

2. The arrow buttons are the navigational buttons that allow you to go from one page 
to another. In the bottom left of the Preview screen is the number of pages for this 
report. 

3. The first printer icon (with the wrench) is the Printer Setup icon. This icon will allow 
you to change to a different printer to print to and allows you to select a print range. 
This is a good selection to choose if you want to only print a partial amount of pages. 
Note: After selecting your print range and clicking OK, you will need to click on the 
Printer icon to print the page. Printer icon – brings up the Printer screen. 

4. Save Report (Export) – this allows you to save a report in one of the following 
formats (pictures are not exported): 
a. QuickReport file (*.QRP) – Normally, you will not need to save it 

in this type of format. This is the format that the Reports themselves 
are written in. 

b. Text file (*.TXT) – exports as a text file. This allows you to open the 
file with any word program.  

c. Comma Separated (*.CSV) – exports as comma separated fields. 
This allows you to open the file with any spreadsheet program. Word 
programs can open it also, but, the formatting may not be right. 

d. HTML document (*.HTM) – exports as an HTML file. This allows 
you to open the file with a Browser. The formatting may be a little 
off. 

e. Excel spreadsheet (*.XLS) – exports as an Excel spreadsheet file. 
This allows you to open the file with MS Excel and other spreadsheet 
programs. This is probably the best choice to export to.  

f. RTF File (*.rtf) – exports as Rich Text Format. This is another good 
choice to export to. Will open in MS Word and other word programs 
that support Rich Text Format. 
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g. WMF File (*.wmf) – exports as a windows meta file. This is a 
format used by Microsoft to transfer graphics between Windows 
applications. Normally, you would not need to export to this type of 
file. Certain graphic programs can open this type of file.  

5. Load Report – This opens a QRP file. Normally, you will not use this.  
6. Close – closes the preview screen and returns to the Report Interface. 
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Appendix B 

Troubleshooting 
 
 
Here are the most common issues that you may experience when using Optima 
applications.  

 
¾ Unable to connect to Interbase Server 
¾ Getting SQL Parse Error: EOF in String Detected message when logging in 
¾ Cannot install on a Win NT or 2000 system 
¾ Exceeded the authorized user count 
 

Unable to connect to Interbase Server 
Users affected 
Optima Attendance Controller 
Optima Confidential Employee Record 
Optima Time Clock 
Optima COBRA  
 
Issue 
When launching one of the programs above the following message may be encountered: 
 
"This program was unable to connect to your Interbase Server. This is likely due to the 
fact that the default Interbase User Account has been change. Please provide a UserName 
and Password with Administrative Privileges to Interbase." 
 
Description 
Users may encounter this issue for one of the following reasons: 
If running from a Server: 
1. If you're using an NT server and trying to install the database files to a drive other 

than C:\, permissions to the database folder may be incorrect. 
 
If running from a Standalone Computer: 
2. Interbase Guardian may be shut down 
 
If running from a Client Workstation: 
3. Incorrect Server Name and/or Database Path 
4. Client needs to have TCP/IP installed 
5. Server may be down 
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Possible Resolution 
1. If running Optima from a Server and encountering the above issue, try each of these 

solutions: 
 
Check your permissions for the Database folder. Full Control access must be given to 
System for the database folder. You may add to the Permissions by going through 
Windows NT Explorer and going to Properties by right-clicking the database folder. 
 
2. Check to make sure Interbase Guardian (or Interbase Manager) is running. 
 
On a Win 95/98 system there will be an icon in the system tray (next to the clock). The 
icon graphic appears as a gray tower with a green flag. When you put your mouse over the 
icon it will read, "Interbase Guardian". This icon will not appear on a Win NT/2000 
system. You may check to see if it is running on a Win 95/98/NT/2000 system by 
clicking on Start, Settings, Control Panel and clicking on the Interbase Manager. If it is 
not running click on Start (from within the Interbase Manager), then try to open the 
Optima application again. 
 
3. If encountering the message when running from a Client Workstation, try this: 
 
Check the Server Name and Database Path by going to the Server, opening the Optima 
application and clicking on Help, System Information and printing out this information 
from the TechSupport tab. (If you don't have the TechSupport tab then you have an 
earlier version of Optima and will need to do a screenshot of the System Information 
screen and Current Users screen and print them out.)  
 
Once you have the Server information, go to the Client Workstation that you cannot 
connect to the Server with. From the Workstation, click on Start, Run, and enter: 
HRWARE.INI. Verify that the Server Name and Database path are the same. 
 
NOTE: The printout of the Server Name and Database path you were asked to print or 
write down when installing the Server side must be exactly the same when entering this 
information on the Client Workstation(s)!  
 
4. The Client needs to have TCP/IP installed. 
This is done through the Network Neighborhood Properties. Please see your Network 
Administrator if you need more assistance in setting this up. 
 
If everything is the same on the Client as it is on the Server and you're still unable to 
connect then try this: 
 
If your Server has a static IP Address, try entering this for the Server name when 
installing to the Client Workstation. 
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5. If running from a Client Workstation and you went through the steps above and it 
didn't fix the issue check with your MIS or Network Administrator regarding the 
status of the Server. 

 
 

SQL Parse Error: EOF in String Detected  
Issue: Getting the above error message when logging in 
 
Description: This is caused when pressing the comma key ( ‘ ) and Enter key at the same  
 
Possible Resolution(s):  
Avoid pressing the comma and Enter key at the same time.  
 
 

Unable to install on a Win NT or 2000 system 
Issue: Doesn’t finish installation 
 
Description: This usually happens if you do not have full administrator rights on the Win 
NT or 2000 computer. 
 
Possible Resolution(s): 
Make sure you have full administrator rights before installing.  
 

Exceeded the authorized user count 
 
Issue: 
You have exceeded the authorized user count. Your product license allows up to [number 
of licensed users] simultaneous users. There are # connections at this time. 
 
The # connections is a number greater than one that changes each time you close and 
reenter the program. 
 
Description: 
Users may experience this issue when closing the program by clicking Exit under the File 
menu. Users who exit the program by clicking the close window icon in the top right 
corner will not experience the problem, but we still recommend downloading and 
installing the latest update.  
 
Possible Resolution: 
Download and install the latest Optima update from our Updates area on our Website at: 
www.gneiltechsupport.com. 
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Please follow the installation instructions. After downloading and installing the update 
follow the steps below to clear the connections. 
 
1. Close Optima and any other G.Neil programs that are open. 
2. Open DB Monitor and log in, if it is not already running. The DB Monitor resides on 

the computer where the Optima database is installed. 
3. Click the Connections button. 
4. Click the Refresh button to verify all connections are "N" (not active).  
5. If all connections are "N", then Click the Clear Inactive Connections button, this will 

reset the connections.  
6. If you wish to close the DB Monitor (not recommended if you have automatic 

database backups scheduled), right-mouse click on the icon G.Neil Database Monitor 
located in the system tray area, select Shutdown Database Monitor, and click OK to 
close DB Monitor. 

7. Otherwise, click the Hide button. 
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Appendix C 

Custom Reports  
 
 

Custom Report Tutorial #1 
A step-by-step guide to modify a custom report template. See Tutorial #2 for creating a 
report from scratch. 
 
GOAL OF THIS TUTORIAL: This tutorial will show you how to create a custom 
report by using a provided template to remove a standard report field and add a new field. 
 
Specifically we will be removing Date of Birth and adding Social Security Number to the 
Employee Summary report in Optima Attendance Controller. 

 
1. TASK: Click Start > Programs > G.Neil > Sample Database. 

 
2. TASK: Select the application you want to run.  

 
3. TASK: From the main menu, select Repor s > Employee > Summary. t

 
4. TASK: Click on the Custom Reports Icon. 

 
 

 
 
TASK: From the Custom Reports main window, click on the Edit Report button. 
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5. You are now presented with the report editing screen shown below. You will notice 
that the field label says “Your Company Name.”  Your first step in customizing a 
template should be to replace this label with your company name. 

 
TASK:  Click on the field “Your Company Name.” 
 
TASK:  In the label field, type “Tutorial Company” or enter your company’s name. 
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6. The next step is to remove the Date of Birth from the report. 

 
TASK:  Click on the top DOB label. 
 
TASK:  Select Edit from the main menu; select Delete as shown below. 

 

 
 

TASK:  Click on the DOB data field. 
 
TASK:  Select Edit from the main menu; select Delete as shown below. 

 

 
 

7. You have now deleted the date of birth heading and data field from the report. The 
next step will be to add the social security label and field to the report. 

 
TASK:  Click on the label button circled below, and click in the “Column Header” band 
as in the arrow below. 
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8. You are presented with the Label Dialog Box shown below. 
 
TASK:  Enter “SSN” in the label field circled below. 
 
TASK:  Click the FONT button circled below. 
 
TASK:  Select BOLD for the font style. 
 
TASK:  Click OK to close the font window. 
 
TASK:  Click OK to close the label dialog box. 

 

 
 

9. The next step is to add the DOB data field. 
 
TASK:  Click on the datafield button circled below and click in the “Detail” band as 
shown below. 
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10. You are now presented with the datafield dialog box shown below. 
 
TASK:  Select “EESSN” from the list of available fields as shown below. 
 
TASK:  Click the OK button. 

 

 
 
Your completed layout should now look similar to the screen below: 
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11. You can preview your results. 
 
TASK:  Select File > Preview from the main menu. 
 
Your preview should look similar to the preview shown below. 
 
TASK:  Click the Close button to close the print preview window. 

 

 
 

12. The next step is to save your changes. 
 
TASK:  Select File > Save as from the main menu. 
 
TASK:  Enter “Custom Tutorial Report” as shown below and Click Save. 
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13. You have now completed this tutorial, to return to the main program, follow these 
steps: 

 
TASK:  Select File > Exit from the main menu. 
 
TASK:  Click Close on the Custom Report Interface. 
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Custom Report Tutorial #2 
A step-by-step guide to creating a custom report from scratch. 
 
Note:  You may use any Optima database application for this tutorial.  
 
GOAL OF THIS TUTORIAL:  This tutorial will show you how to create a custom 
report from scratch using the Custom Reports, custom-reporting tool provided in Optima 
Attendance Controller. 

 
1. TASK: Click Start > Programs > G.Neil > Sample Database. 
 
2. TASK: Select an Optima application to run.  

 
3. TASK: From the main menu, Select Repor s > Employee Detail. t

 
4. TASK: Click on the Custom Reports Icon. 

 

 
 

5. TASK: From the Custom Reports main window select New Report. 
 

 
 

113 



 

6. The screen shown below is the Custom Reports Design Window. This window is 
used for report creating and updating. When you select New from the main window, 
the designer first presents you with a report wizard. The report wizard assists you in 
creating a basic report. For the purposes of this tutorial we will not be using the 
wizard. Instructions for using the wizard are provided in your Custom Reports 
documentation.  

 
TASK: Select New blank report and Click Next. 

 
 
7. We are now ready to begin designing our report. Data reports are designed with 

report bands. A report band is an area of data or text, which will repeat based on 
criteria we set at design time. Let’s start with the first band common in most reports: 
The Title Band. 

 
TASK: Click on the Band button circled in the screen shot below.  
 
TASK: Click anywhere on the design page to drop the band on the page. (The design 
page is the white area filling the center of the window with grid lines.) 
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8. We are now presented with the “Band Editor” window. Note the Type of band is set 
to Title. This window has many advanced options which are covered in the Custom 
Reports documentation. 

 
TASK: Click OK to place the Title band on the design page.  

 
 
9. The design page should now contain BAND1 as shown below. You will notice that 

BAND1 also shows that it is a Title band. Any text and/or data which is placed in 
the title band will be the first thing printed on your report. It will print only on the 
first page of the report – hence the name “Title”. 
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10. We will be designing an employee mailing list report; therefore, we want the title of 
our report to say “Employee Mailing List”.  

 
TASK: Click on the Text button circled in the screen shot below.  
 
TASK: Click in the middle of the Title Band (BAND1). 

 

 
 

11. You are now presented with the Label window.  
 

TASK: On the line where it says “ReportLabel,” type in “Employee Mailing List.”    
 
TASK: Click OK. 
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12. Your screen should now look similar to the one shown below. The next step is to 
center the label in the band.  

 
TASK: Click on the “center horizontally” button circled below to center the label in the 
band. 

 

 
 

13. Now we need to add another band.  

TASK: Click on the Band  button and Click in the design window.  
 
TASK: Choose “Column Header” for Type and Click OK. 
 
TASK: Click the Band button again and Click in the design window.  
 
TASK: Choose “Detail” for Type and Click OK.  

 
Your design window should now contain a total of three bands (Title, Column Header, 
Detail) as shown in the screen below: 
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14. The next step is to add the data fields to the Detail band. 
 

TASK: Click on the data field button circled in the screen shot below.  
 

 
 

TASK: Click inside of the Detail band to bring up the “Data Field” window shown 
below. 
 
TASK: Select the field “FIRST” from the pull down menu as shown below. 
 
TASK: Click the OK button. 
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Continue adding data fields so that your detail band is laid out as shown below. 
 

 
 

15. Now we need to change the size of font for the fields on the report.  
 

TASK: To select all of the fields on our report, hold down your Shift key on the keyboard 
and keep it down while Clicking on each field (FIRST, LAST, ADDRESS1, ADDRESS2, 
ADDRESS3).  
 
TASK: Click on the font size dialog box shown below and set the font size to 8. 

 

 
 

16. Now we are ready to fill in our Column Header band. This band will be printed on 
the top of our Detail band and is generally used for printing the names on columns 
on the report. We need to add text labels over the top of each datafield in the detail 
band. 
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TASK: Use the Text  button to add the text “First Name” above the [FIRST] 
data field in the Column Header band. 
 
 
TASK: Continue adding text labels to the Column Header band above each data field so 
that your screen matches what is shown in the picture below. 

 

 
 

TASK: Select all the text labels in the Column Header band by holding down the SHIFT 
key and Clicking on each of them.  
 
TASK: Set their font size to 8 and turn on the Bold and Underline properties by Clicking 
on the “B” and “U” buttons. 

 
 

17. Add the Date and Time to your report.  

TASK: Click on the System Field button.  
 
TASK: Click in the top left hand corner area of the Title Band. 

18. After dropping the System Field in the Title Band, you are presented with 
the System Field Window shown below.  

 
TASK: Select Date/Time as the Type as shown in the screen below. 
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TASK: Click OK. The (Date/Time) text should be in the Title Band as shown in picture 
above. 
 

 
 

19. Add one final band to your Report.  

TASK: Click on the BAND button  and then click in the design window.  
 
TASK: Select “Summary” as the type.  
 
TASK: Click OK. Your screen should look like the one shown below: 

 
 

20. Add a text label to the Summary band. 
 

TASK: Click on the Text field button . 
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TASK: Click inside the Summary band.  
 
TASK: Type “Total Records”: in the Label field and Click OK. 
 
TASK: Set the label font size 8, Bold and Underlined.  
 

TASK: Click on the System field button . 
 
TASK: Click inside the Summary band.  
 
TASK: Set the Type as “Detail Count” and Click OK. 

  

 
 

21. Optional – Advanced Reporting Features – Script Language 
 

The following section shows you how to add a small piece of Script Code to your report. 
This section is optional; if you wish to skip this section go to Item 30. 
 
Custom Reports provides an advanced way for you to add flexibility and creativity to your 
reports using script language. A detailed explanation of this feature and its use are 
provided in the Custom Reports documentation. 
 
In order to access an item on your report, whether it’s a field label or a text label, it must 
have a name. In this example we will be adding code to access the labels in the summary 
band; therefore, we must give them a name.  
 
TASK: Select the text label “Total Records” by clicking on it with your LEFT mouse 
button. It should appear selected by having six small boxes around its perimeter as shown 
below. 
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TASK: Now that it’s selected, click on it with the RIGHT mouse button. A small drop 
menu will appear as shown below.  
 
TASK: Click on Options. 

 
 

22. This will bring up the options window for this text label as shown below.  
 
TASK: Enter TOTALRECORDS in the Name field and click OK. 
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23. We have now given the “Total Records:” text label the name “TotalRecords.”  A 
name is required in order to access this label in the script language. We must now 
give a name to the Detail Count label. 

TASK: Click on the [Detail count] field. It should appear selected. 
 
TASK: Right-click on the [Detail count] field. 
 
TASK: Click on Options.  
 
TASK: Enter DETAILCOUNT in the Name field and Click OK.  

 
24. Now that these 2 labels have been given names we can access them in code. Script 

code is normally attached to the band which contains the labels you wish to modify. 
In this case, since these labels are in the summary band, we will enter the code into 
the summary band’s script window.  To do this, select BAND4 (the summary band); 
we need to make it the active band. 

 
TASK: Click on the Summary band (BAND4). The summary band should now be 
highlighted.  
 
TASK: RIGHT-click inside of the summary band. Be sure your mouse pointer is over 
one of the fields in the Summary band – you must click in an open area of the band. You 
should see the drop-down menu shown below.  
 
TASK: Click on Scripts.  
 

 
 

This will bring up the Scripts window as shown below. This is the window where you 
enter the script code. This window contains 2 tabs – Before Print and After Print. Any 
code entered in the Before Print window will execute before the band prints. Any code 
entered in the After Print window will execute after the band prints. If you want to add 
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code to modify the look or layout of text in the band, it must be executing before it 
prints; therefore, we will enter our code in the Before Print window.  

 
TASK: Enter the following code in the Before Print window: 

 
If (DETAILCOUNT>0) 
  SetFontColor(‘TOTALRECORDS’, Blue) 
Else 
  SetFontColor(‘TOTALRECORDS’, Black) 
Endif 
 
The above code tells Custom Reports to do the following:  If the DetailCount is greater 
than 0, set the color of the label TotalRecords to Blue; otherwise, set the color of the label 
TotalRecords to Black.  

 
TASK: Click OK to save the report code. 
 

 
 

25. The basic layout of our report is now complete. The next step is to save our report.  
 
TASK: Select File > Save from the main menu.  
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TASK: Enter “Employee Mailing List” as the name of this report and Click Save. 

 
26. We can now preview the results of our report.  
 
TASK: From the main menu select File > Preview.  
 
Your view of the report should look similar to the screen below. If you did the Optional - 
Advanced section the Total Records: line at the bottom of your report should be 
colored blue. 

  
TASK: To exit the Print Preview, Click Close.  
 
TASK: To exit the report designer, from the main menu, select File > Exit. If you’re 
prompted to save the report, select Yes.  
 
TASK: To exit the Custom Reports main window, click Ex . it
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Appendix D 

Import/Export File 
Format  
 
 
You may import and export only the fields on the Field Layout page. There are two 
different formats that you may use: Tab Delimited and Fixed Length.  
 
For a Tab Delimited format you may use any program that allows you to save as Tab 
Delimited. Excel and Access are two that will allow this. This is the easiest format. 
 
When entering your information into a spreadsheet such as Excel, you will need to follow 
the order of the field names according to the Field Layout page.  
 
For example, the columns should have SSN first, then Last Name, First Name, etc. Also, 
you will need to leave a blank column for any fields that you will leave blank. For 
example, following the format on the Field Layout page, we create a Tab Delimited file 
with the fields: SSN, Last Name, First Name, [blank column for Middle Initial field], 
Location, Department, Date of Hire, Full/Part Time, [blank column for Title field], 
[blank column for Employee Code field] and Active Status. All of the fields in bold are 
required. You still need to have a blank column for MI, Title and Employee Code in the 
order of the fields.  
 
For a Fixed Length format, you may use the DOS Editor or any other editor that shows 
you the field length. The lengths of each field must correspond to the Length column 
under the Field Layout page. We recommend using the Tab Delimited format.  
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The following is the field layout for importing text files into Optima COBRA. Fields 
shown in bold type are required and all import text files must include them. 
 
Field Layout 
 

Field Name Length Format 
 (if fixed  

length format) 
 

Social Security Number 11 123-45-6789  
Last Name 20 up to 21 characters 
First Name 20 up to 21 characters 
Middle Initial 20 up to 20 characters 
Location 50 up to 25 characters or numbers 
Department 50 up to 25 characters or numbers 
Date Of Hire 10 MM/DD/YYYY (slashes required) 
Full/Part-Time 10 Full-Time or Part-Time (only) 
Title 30 up to 30 characters or numbers 
Employee Code 14 up to 14 characters or numbers 
Active Status  10 Active or Inactive or Terminated (only) 
   
If you have Optima Records installed, your text file can also include these fields: 
   
Date of Birth 10 MM/DD/YYYY (slashes required) 
Address 1 30 up to 30 characters or numbers 
Address 2 30 up to 30 characters or numbers 
Home Phone 30 800-123-4567 (dashes required) 
City 30 up to 20 characters or numbers 
State  2 Standard U.S. two-letter code (e.g., FL) 
Zip Code 15 33325-1234 (-1234 can be omitted) 
Salutation 5 Mr. – Ms. – Mrs. – Dr. (only) 
Employee Security Level 16 up to 16 characters or numbers 
Security Clearance Date 10 MM/DD/YYYY (slashes required) 
Race 25 Must match a valid race on the Employee 

Detail Feature 
EEO Category 25 Must match a valid category on the Employee 

Detail Feature. 
Sex M/F 1 M or F only 
Driver’s License Number 15 up to 15 characters or numbers 
I9 Renewal Date 10 MM/DD/YYYY (slashes required) 
Veteran Status 25 Disabled – Vietnam Era – Other Veteran –      

Not Applicable (only) 
Office Phone & Ext. 30 800-123-4567 Ext. 123  
Fax 30 800-123-4567  
Email address 30 up to 30 characters or numbers 
Address Effective Date 10 MM/DD/YYYY (slashes required) 
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Appendix E 

Using the 
Notes/Comments Editor 
and Attachments 
 
 
Optima has powerful word processing features for all comments and notes fields, as well 
the ability to attach objects and documents within these fields. When documenting 
employee absences, you may find it useful to attach  
¾ Copies of e-mails  
¾ Word or Excel attachments that you’ve used for tardies, warnings and specific 

sections of reviews 
¾ MyBiz Forms personnel forms for vacation requests, FMLA requests and company 

responses, warnings and counseling reports 
 

Right-Click Menu Commands 
Right-click on any notes or comments field – the menu shown 
at right will pop up with the following options:  
 
Edit – Opens the full text editor 
Cut – Copies to the clipboard and deletes the currently 
selected text 
Copy – Copies the currently selected text to the clipboard 
Paste – Pastes the currently selected text into the comments or 
text field 
Font – Brings up a standard font edit window, with settings 
for font, style, size, effects and color 
Bullet Style – Toggles bullets for selected paragraphs on and 
off 
Paragraph – Brings up a standard paragraph settings window 
for alignment style, indentation, and line spacing 
Tabs – Lets you set tab stops for selected paragraphs 
Find – Searches for the text you enter 
Replace – Searches and replaces text according to your settings 
Insert Object … – Opens the Insert Object window and lets you select either a type of 
new object to insert into the notes/comments field or attach an existing file 
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Check Spelling – Launches the Microsoft® Word spellchecker (must be installed) 
 

Using the Rich Text Editor 
When you right-click and select Edit, the text editor opens in a separate window, giving 
you access to all Right-Click Menu commands in a word-processor-like environment. 
Here’s a brief overview: 
 

 
 
Toolbar 

 
New Creates a new document. 

 
Print Prints document. 

 
Find Finds specified text. 

 
SpellCheck Checks spelling. Requires MS Word installed. 

 
Cut Cuts selection and puts it on the clipboard. 

 
Copy Copies selection to clipboard. 

 
Paste Pastes selection from clipboard. 

 
Undo Reverses the last action. 

 
Redo Reverses the last Undo action. 
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Format Bar 
Font Type Changes the font selection. 

 
Font Size Changes the font size. 

 
Bold, Italic, 
Underline 

Changes the font to Bold, Italic or Underline. 

 
Font Color Changes the font color. 

 
Left, Center, Right 
Alignment 

Changes the text to Left, Center, or Right 
Alignment. 

 
Bullet Inserts Bullet. 

 
Highlight Highlights selected text.  

 

Adding Attachments to Comments or Notes 
Each Comment or Note field allows you to insert an attachment to that field. 
Attachments can be a Microsoft® Word Document, Microsoft® Excel spreadsheet, PDF, 
Rich Text Format, or even a picture file. Attachments may be linked to a file, displayed as 
an icon or inserted into the field. 
 
Inserting an Attachment 
To insert an attachment, follow these steps: 
1. Locate the Comment or Note field you want to insert an attachment into.  
2. Right click on this field and select Insert Object. 
3. Select Create from File.  
4. Click Browse to navigate to the file you want to attach and click Open. 
5. Select Display as Icon.  
6. Click Change Icon and change the Label, if necessary, to make the name more 

descriptive. 
7. Click OK, then OK one more time. 
 
Insert Object Options 
Create New 
Selecting Create New allows you to insert a new object that you want to create from 
scratch. For example, selecting Create New and clicking on Microsoft® Word Document 
for the Object Type and then clicking OK will bring up a blank Word Document for you 
to enter text. When you close out of the Word Document it will appear in the Comments 
field. Double-clicking on the Word Document object will bring up Microsoft® Word so 
that you may again edit the document. 
 
If the Display As Icon option is checked, then the Word Document (or object type) will 
appear as an icon in the Comments field. 
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Create from File 
Selecting Create from File will allow you to insert an existing object type, such as a 
Microsoft® Word document, PDF file or Excel spreadsheet. Normally, this will be the 
option you will use for every day use. 
 
If you do not select the Link or Display as Icon option, then the object type will be 
inserted into the Comments field. In other words, you will see the text as you would see 
the text on a Word Document within the Comments field. Double-clicking on this text in 
the Comments block will bring up Microsoft® Word so that you may edit the document. 
 
We recommend selecting the Display as Icon option when inserting an object. This 
inserts the object type within the Comments field; however, it shows as an icon. When 
you double-click on the icon, it brings up the object within the program that created it. 
 
The Link and Display as Icon options will perform the following, depending on your 
selections:  
 

Selected  
Link Display as 

Icon 
Results 

  Inserts the contents of the file as an object into 
your document so that you may activate it using 
the program which created it. 

X  Inserts a picture of the file contents into your 
document. The picture will be linked to the file 
so that changes to the file will be reflected in 
your documents. 

 X Inserts the contents of the file as an object into 
your document so that you may activate it using 
the program that created it. It will be displayed 
as an icon. 

X X Inserts a shortcut that represents the file. The 
shortcut will be linked to the file so that 
changes to the file will be reflected in your 
document.  
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Appendix F 

Quick Start Guide 
 
 
This appendix is for those wanting to get up and running quickly with Optima COBRA. 
For more detailed instructions please see the appropriate section within this manual.  
 

Installing Optima COBRA  
To install Optima COBRA, insert the CD-ROM into your CD-ROM drive; the 
installation process should start automatically. Follow the on-screen prompts to continue. 
If the installation process doesn't begin automatically, select RUN from the START Menu 
and enter D:\Setup.exe where D: is the letter of your CD-ROM drive. Click OK to begin 
the installation process.  
 
NOTE: Optima products are for standalone installations. These products can be installed 
on one computer only, however, you may give access to different users to use the 
program from that computer. If you need to have others access the database in a network 
environment, and/or need to enter more than 100 active employees, then you should 
look to our Optima programs. (See www.gneil.com/optima for more info.) 
 

Pre-Setup Instructions 
If setting up Optima COBRA for the first time, you will need the following information: 
¾ Location and Department names – These are required fields within Optima when 

entering employee data. (Such as Location: Miami, Department: Merchandising.) 
¾ Benefit Plan info – Benefit info such as Medical and Dental rates, insurance company 

contact info, employee and employer rates.   
¾ User Info – Who will have access to the COBRA software? This will be for setting 

up or administrating purposes.  
¾ Employee Info – Data such as Employee Name and number, Date of hire, spouse 

and dependent info, benefits elected or waived, COBRA info. 
 

Program Setup 
The following information is designed to get you up and running in the quickest way 
possible. For detailed instructions on any of these topics please see the appropriate title in 
the manual or help file.  
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Checklist 
This checklist will help guide you in setting up Optima COBRA in the recommended 
order: 
1. Change Admin Password (Default Login and Password is: ADMIN) and Set Up 

Access for Other Users 
2. Set up Global Preferences 
3. Set up Locations and Departments 
4. Set up Benefit Plans 
5. Enter Employee Data 
6. Assign Benefits to Participants 
7. Add Additional Users 
 
1. Change Admin Password and Set Up Access for Users 

(Settings > User Security) 
We highly recommend changing the Admin password immediately upon setting up the 
program due to the confidential nature of the information. Also, you'll want to give access 
to anyone who will be setting up or entering data into Optima COBRA.  
 
CHANGING THE ADMIN PASSWORD  
To change the Admin Password, from within the program, go to Settings > User Security.  
 

 

Detail and 
COBRA buttons 

Password field 

Click in the 
Access Rights 
field to bring up 
access options 

 
The ADMIN User Login record should be highlighted. Click in the Password field, enter 
the new Password and then re-type it in the Verify Password field and click Save. The 
next time you login under the ADMIN User, you'll need to enter the new password.  
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SETTING UP ACCESS FOR OTHER USERS 
From the User Security screen, click New. Enter a Log In name, Full Name and Password 
for this new user. (The Log In name and Password is what the user will enter into the 
program to gain access.) 
 
Next, while on the Detail button, select what type of access rights you want this user to 
have for each general feature. (See Chapter 4 - Security Options for more information.) 
Click on the COBRA button and assign access to the COBRA specific features.  
 
NOTE: If you need to set up users access to only specific location/departments and/or 
employees, these will need to be set up first. For example, if a Sales Manager only needs 
access to his department, you'll need to set up the Locations and Departments into the 
program. 
 
2. Set Up Global Preferences (Settings > Global Preferences) 
It is important that you enter all requested information in the area titled “COBRA 
Administrator” under Global Preferences > COBRA Tab before getting started.  Failure 
to do so may prevent your COBRA Notifications from generating, and may interfere with 
other important COBRA administration features. NOTE: Your company logo should 200 
x 200 pixels. (See Chapter 2 - Company Information for more information.) 
 
Also, note when entering settings under the COBRA tab, you have the option to Use 
Fees from Plan Rate Tier; These tiers are set up under Benefit Plan Maintenance.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use fees from Plan Rate Tiers - 
This option will default to either
use fees from actual benefit plan
(checked) or fees listed here. Fee
can be changed at any time when
setting up the plan. 

Default for To Do List days out -  
This is how many days ahead of time
the program will display any Notices
or Billing Records on the To Do List. 
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3. Set up Locations and Departments 
Departments are assigned to locations, so locations should be created first, then create 
your departments, then assign departments to a location.  
 
 
 

 

Location/Department buttons

Click New  
then enter name 

Assign departments 
by selecting 
departments under  
the appropriate 
location 

   
CREATING LOCATION AND DEPARTMENT NAMES 
 Select the Locations button first. 
a. Click New. 
b. Enter the name for the location. 
c. Click Save. 
d. Enter other locations as needed following steps b - d. 
e. Select the Department button next. 
f. Click New. 
g. Enter the name of the Department. 
h. Click Save.  
i. Enter other departments as needed following steps g - i. 
 
ASSIGNING A DEPARTMENT TO A LOCATION 
After your location and department names have been created, you'll notice that each 
location has each department name underneath it with a checkbox. 
 
To assign the department name to a location simply select the department name (put a 
check mark in the checkbox) under the appropriate location. 
 
Now whenever you choose a location, such as from the Employee Detail screen, in the 
Department drop-down field, you'll only see the assigned departments associated with 
that location. 
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4. Set up Benefit Plans (Settings > Benefit Plan Maintenance) 
Benefit Plan Maintenance is where you will enter your Company's benefit information, 
such as the names of the insurance companies you have, rates and tier information, etc.  
 

 
 
 

 
 
 

• Require Beneficiaries – For plans where you need to
enter beneficiary info. Displays a Beneficiaries button
when assigning benefits to employees. 

• Employee Only Benefit – For plans that are only for
employees. Only displays employee name when
assigning benefits. 

• Enable COBRA for this plan – Displays the option for
the COBRA button on the Benefits feature. 

• Termination Date - The date the plan terminates. 
 

Plan Rate Tiers 
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5. Enter Employees and Personal Contact Info 
Next, you'll want to add employees to the database, then add contact info which will be 
used to identify spouse and dependent info for benefits.  
 
ENTER EMPLOYEES (Employee Details Feature) 
Click New to enter a new employee. First Name, Last Name, Hire Date, Location and 
Department are all required fields. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Employee Detail 
allows you to enter and 
view employee info 

First, Last Name, 
Hire Date, Location and 
Department are required 
fields 

 
Having accurate Day and Week Hours for each employee is important too. Optima 
COBRA uses the Week Hours to determine whether an employee is eligible for a benefit 
depending on the Minimum Week Hours set for each benefit plan.  
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ENTER PERSONAL CONTACT INFO (Personal Contacts Feature) 
We recommend entering an employee (through the Employee Detail screen) then enter 
their dependent information for that employee (through Personal Contacts Feature). You 
may also enter all of your employee data first then go back and enter all the dependent 
information. This information will be needed when assigning benefits to employees and 
their dependents.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Personal Contacts -  
Allows you to enter spouse and
dependent status info that is
needed for COBRA, and
emergency contact info 

Dependent Status 
and Address Info 

 
Be sure to enter dependent and address info along with the first and last name. The 
dependent status will be important when assigning benefits and the address will be 
important when printing notifications.  
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6. Assign Benefits to Participants (Benefits Feature) 
The Benefits Feature allows you to assign benefits to employees, their spouses and 
dependents (participants). After a benefit is assigned to a participant(s), then you can 
create a COBRA event, such as Reduction in Hours, End of Employment, Loss of 
Dependent Status, among others. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Benefits - 
The Benefits feature is where you
assign benefits to employees and their
dependents and enter COBRA events 

Benefits Detail COBRA Detail 

As you fill in fields other fields will become available. Participants on this plan
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7. Add Additional Users (Settings > User Security) 
At this point, everything is basically set up. You can add additional users who you want to 
give access to, down to the employee level now that you have your locations, departments 
and employees entered.  
 

Other Quick Tips 
 
About To Do List  
Now that Optima COBRA is set up, you'll get a To Do List of notifications that need to 
be printed and mailed whenever you open the program. You may also get to this list by 
going to the View Menu > COBRA Tasks, and you'll be able to view this information for 
each individual employee from the COBRA Notices Feature. Colored Records mean: 
White - Printed; Green - No action needed yet; Yellow - Becoming due. Need to print out 
and mail notice soon; Red - Past Due - needs immediate attention. The To Do List tasks 
and dates are generated by Optima COBRA based on information you have entered and 
the legal timeframes imposed by COBRA requirements. (See Chapter 3 – Notifications 
and Timeframes under What You Need to Know About COBRA.) 
 
About COBRA Billing 
COBRA billing records are automatically created when a COBRA event is recorded. 
Optima COBRA gives you the ability to also create a new billing record or edit an existing 
amount, however, we recommend having the program automatically create the record for 
you from the COBRA event.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Receiving a Payment 

3

1. Enter the payment 
amount received. 

2. Select the row(s) to 
apply that amount  
against from the 
available billing records.

3. Or enter the amount 
applied directly into the  
Payment Amount field.

2

1

COBRA Billing - 
Billing records are 
automatically created when a 
COBRA event is recorded.  
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